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  Introduction   

Introduction 
Welcome to the user guide for the DME client version 3.6 for Windows Mobile. 
This guide is divided into three parts: 
1 An introduction to DME - about the company Excitor A/S and what the DME 

system does. 
2 A description of various general concepts of the DME client. 
3 A description of each feature and function in the DME client. 
Administrators: For information about rolling out the DME client to many users, and 

detailed information about installing the client on all platforms, please see the 
Provisioning part of the DME Server Reference. 

 
Please note that this version of the DME client is compatible with both 3.5 and 3.6 
DME servers. Some features described in this manual only apply to DME 3.6 servers.  
The main areas of functionality supported by 3.6 and not 3.5 are the following: 
 RSS feeds 
 Notes/Journals synchronization 
 Out of Office rules 
 Enhanced e-mail status (icons for replied to, forwarded, and follow-up flags) 
Whenever there is a difference, this will be indicated in the manual. If you are missing 
a feature in the client that is described in this manual, it may be because your DME 
server does not support it. 
 

Copyright information 
Copyright © 2007-11 Excitor A/S. 
All rights reserved. 
Due to continued product development, this information may change without notice. 
The information and intellectual property contained herein is confidential between 
Excitor A/S and the client, and remains the exclusive property of Excitor A/S.  
If you find any problems in the documentation, please report them to us through our 
customer support services. Excitor A/S does not warrant that this document is 
error-free. Furthermore, Excitor A/S does not warrant that the illustrations and 
screenshots used in this document reflect your version or the latest version of the 
program described. For the latest version of this product documentation, go to the 
DME website DME http://www.excitor.com. 
No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, 
recording or otherwise without the prior written permission of Excitor A/S. 
DME, DME Sync, VoiceExtender, SmartEncrypt, and AdaptivePush are trademarks 
of Excitor A/S. 

http://www.excitor.com/
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Microsoft SQL Server, Microsoft Exchange, Windows, Windows Server 2003, 
Windows Server 2008, and Active Directory are trademarks or registered trademarks 
of the Microsoft Corporation in the United States and other countries. 
Lotus Notes® and Domino® are trademarks or registered trademarks of IBM 
Corporation, registered in the U.S. and other countries. 
Apple, Apple iPhone, iPod touch, and iPad are trademarks or registered trademarks of 
Apple Inc., registered in the U.S. and other countries. 
All other trademarks are property of their respective owners. 
 

Company information 
 

12, Spotorno Allé 
2630 Taastrup 
Denmark 
Phone: +45 70 21 68 00 
E-mail: mail@excitor.com 
Website: DME http://www.excitor.com 
 

About DME 
DME (Dynamic Mobile Exchange) offers synchronization of push e-mail, PIM 
information (calendar, contacts, to-dos), and optionally files, to mobile devices. It 
fully integrates mobile device management with state-of-the-art security and efficient 
software deployment. DME is a mobile client/server solution that works with mobile 
phones, smartphones and PDAs using Android, Apple iOS, Symbian, Windows 
Mobile, or Windows Phone*) as operating system. DME is developed by Excitor A/S. 
The solution enables large and mid-size enterprises to deliver business mobility 
services to employees and to effectively manage and control mobile devices without 
compromising security. DME is device, network and operator independent and offers 
unparalleled TCO, unprecedented data and device security, and a very intuitive 
interface for users and administrators. 
*) Please note that not all server features are supported on all platforms. Contact 
your DME Partner for specific inquiries. 
 

http://www.excitor.com/
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Features and benefits 
 Convenient for the user: Push e-mail, calendar, contacts and to dos 

With DME on your mobile phone, smartphone, or PDA, you get your most critical 
and often used office tools in your pocket wherever you are, whenever you need it. 
E-mails appear on your phone the moment they hit your office mailbox.  

 Quickly back in the game: Instant service recovery 
Should your phone get lost or stolen, a new DME client can be pushed to a new 
phone in a few minutes after you purchase a new DME supported phone or borrow 
one from someone else – no matter where it happens. 

 Fretless security: Mobile security policy enforcement 
E-mails are encrypted over the air and on the device itself using full encryption 
(AES 128-bit or stronger). Shell protection of the entire phone, requiring domain 
password to access all features except picking up calls, gives you further security 
options. 

 Freedom and ease-of-use: Effective control of all devices 
Gain a complete overview of your devices – regardless of make, model, or 
platform. Information about the device model, versions and programs installed on 
the device is listed in the web-based DME control center for easy administration. 
Features, settings and available applications and network connections are all 
controlled centrally and can only be changed by the users to the extent this is 
allowed by centrally applied security policies. Dividing the devices into groups 
makes it easy to change settings/features for many devices at a time. 

 Ease-of-use comes in many flavors: Simple support and administration 
Push software and upgrades via OMA, Apple MDM, SMS or WAP to the users, 
permit them to serve themselves, or automatically upgrade software when the 
users log on. For support purposes, retrieval of device configurations and 
connection set-up makes it possible for you to help users who cannot connect, and 
a log of user actions assists you in identifying the problems and solving them. 
Notification of changes to server status can be sent to the DME administrators to 
ensure they are alerted to problems quickly. 

 Cost containment: Control of ongoing mobile cost 
Data and voice logging allows you to monitor activity levels real-time, and 
identify “expensive” behavior which can be reduced. Heavily-used operators can 
be determined and connection preferences can be set as default. Build advanced 
reports to get a clear view of your organization’s mobile traffic using the 
integrated BI reporting tools. Link to a third-party Telecom Expense Management 
provider to build detailed reports, for instance for internal billing. 

 Freedom of choice: Versatility 
Works on any available network (WLAN/Wi-Fi, GSM, GPRS, 3G/UMTS, 
EDGE...), operator, and on most devices from leading manufacturers. Works on 
Lotus Domino and/or Microsoft Exchange collaboration systems. 

Please note that the above applies to the full DME client. Note also that due to 
limitations specific to the some client platforms, a few of the features mentioned 
above are not supported on DME for those platforms. Contact you DME partner for 
specific inquiries. 
 

Terminology 
The following is a list of terms used in this guide, and an explanation of the term. 
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Term Explanation 
DME Often used for the DME Client. 

DME Server The DME Web Administration Interface. 

Collaboration system The server-based e-mail and calendar system that your 
company runs - either Lotus Domino (with Lotus Notes as 
the user front-end) or Microsoft Exchange (with Microsoft 
Outlook). 

DME menu The DME menu is the main menu in the DME interface. 
On some devices, you have to select Options to access the 
menu, on some you select More. 

Select To choose an item or a menu option, whether by clicking, 
tapping, or choosing in a menu. 

In some cases, there is more than one route to selecting an option. For instance, on 
some devices you can create an e-mail either by selecting Options > Create > E-mail 
or by tapping a New e-mail icon directly. The manual will usually only mention the 
regular menu route. 
 



 

  General concepts   

General concepts 
The following sections contain information that is good to know before you begin to 
use DME. The issues apply to clients of all or most platforms, and deal with the 
following: 
 Time zones 
 Security 
 Synchronization and import 
 Cost-saving features 
 

Time zones 
With DME, you can always keep your office in your pocket - including your office 
calendar. One challenge with calendars is the fact that sometimes we operate with 
multiple time zones. If we travel to a different time zone, we need to make sure that 
entries in our calendar reflect the change in time zones. An appointment made for 2 
o'clock in the afternoon at your home office should be shown at 1 o'clock if you travel 
one hour west. 
In order to keep your calendar updated this way, no matter where you are, DME uses 
the time zone setting of your device. The device is typically set up to get the correct 
time from the network operator, in which case a message from the operator will tell 
you that your time zone has changed, and offer to adjust the time zone on your device 
for you. You should allow this, or adjust it yourself if the device is set up to a fixed 
time zone. 
When you adjust the time, your calendar will remain up-to-date. The calendar entries 
are shifted correctly in time without communication with the DME server. 
 

Data security 
DME has a strong focus on security. All e-mails are securely stored on the device - 
even if the SIM card is changed or the battery runs out after you have logged in. All 
data remains encrypted at all times using strong encryption, and is only decrypted to 
memory while it is displayed on screen. 
All communication with the server is encrypted, and the server can be set up to require 
a client certificate, which further prevents attempts at unauthorized access from 
devices that are unknown to the server. 
It is not possible to export any data from the device to be read elsewhere. Even the 
clipboard is cleared of any text cut or copied to the clipboard when you exit the client 
(as of version 3.6). 
All DME-related data on the device (e-mails, calendar items, to-dos, contacts, and 
synchronized files, and other data: SMS messages, data on the memory card and 
internal memory) are deleted in the following events: 
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 If the SIM card is changed (if set up by the DME administrator). See Changing 
SIM cards on page 9 for more information. 

 If the user name or password is entered incorrectly a number of times (as set up by 
the DME administrator). 

 If the DME administrator decides to do it. If the device is lost or stolen, the data 
on the DME client can be cleared remotely by sending a command from the DME 
server (remote wipe). You should always contact your DME Administrator 
immediately if you lose your device. 

In case a new user logs in, all DME-related data are deleted before the Desktop or 
Inbox is shown. 
 

Changing mailbox passwords 
Depending on your company's security policy, you must change your network 
password at regular intervals. If you use Exchange, your network password is the 
same as your mailbox password, but on Domino collaboration systems this is not 
necessarily so. The DME client depends on the mailbox password to gain access to 
synchronize your e-mail to the device. 
Your mailbox password can be changed from your desktop computer or from your 
device. If your collaboration system is based on Active Directory, a message may pop 
up telling you well in advance that it is time to change your password. If you ignore 
the warning, your current password will eventually become invalid, and you will be 
unable to log on to the system. 
You can either change your password from a desktop computer on the network or 
from the DME client.  
 If your mailbox password is changed from a desktop computer on the network, 

and you have exited DME (for instance in connection with a phone reboot) so that 
your credentials are no longer encrypted in memory, then the new password has to 
be verified on the server the first time you log in to the DME client. When you log 
in, and DME recognizes you as a user and recognizes your password, but detects 
that the password has been changed on the server, the following message is 
shown: 

 
You are then asked to enter your new password. 
1. Select Yes to verify the new password on the server. 
2. Enter your old password. 
3. Select Log in. 
You can now use DME as usual. 
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 If your mailbox password is changed from a desktop computer on the network, 
and your device still has your credentials encrypted in memory: If you are logged 
in, DME will log you out the first time the device communicates with the server 
(for instance in connection with a network push). When you log in again, you 
should use your new password. DME will assume that you have changed password 
on the server, verify your new password, and re-encrypt your credentials without 
you having to confirm any messages. 

 You can change your mailbox password from the client.  
1. Log in to the client as usual. 
2. Open the DME menu, and select Tools > Change password. 
3. Enter your existing password in the Old password field. 
4. Enter a new password in the New password field, and retype it in the 

Confirm new password field. 
5. Select Change. 

 
DME sends the password change request to the server. If the server accepts the 
request, a message tells you that your password has been changed. If the server 
rejects the request, a message tells you why the command failed. If the command 
fails, it can be an issue with the server setup, and you should contact your DME 
Administrator. 

 

Switching users 
Unless forbidden by the DME Administrator, you can hand over your device to 
another person, even if it contains all your DME data. All e-mails,  calendar items, 
to-do items, contacts, and other synchronized files and resources will be erased when 
the new user logs in. 
The new user is taken through the same verification process as described in Logging 
in on page 17. 
 

Changing SIM cards 
If you change the SIM card in your device, the DME client will ask for the new phone 
number the first time you log in to the DME client. It is important that the phone 
number is correct, as many features depend on the DME server's ability to send 
commands by SMS to the device. 
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1 Enter the phone number. 
2 Select OK. 
The device phone number can also be changed in the general settings (see General 
settings on page 66). 
Depending on the setting Action on SIM card change in the security settings, your 
DME data will be wiped from the device when you change the SIM card, or your 
device will be locked, or you are allowed to log in as usual. 
 

Synchronization overview 
The basic idea of the DME client is to keep the e-mail, calendar system, contacts, and 
other resources on your mobile device up-to-date with the corresponding items on the 
corporate network. To do this, the DME client is synchronized with the collaboration 
system or the file server. E-mails, calendar items, contacts and other resources are 
synchronized with the corporate collaboration system. 
On some platforms, you can also synchronize files on the DME server or in a network 
location with your mobile device. File synchronization requires a special license - 
consult your DME administrator for more information. 
 

What is synchronized 
In the synchronization (sync for short) process, DME checks the following: 
1 Have any items been created? An item could be an e-mail, a contact, a calendar 

item, a to-do, or possibly a file. If an item has been created, it is copied to the 
system on which it does not yet exist (for example, if an e-mail was created and 
sent from the mobile device, the e-mail is copied to the Sent folder on the 
collaboration system).  
Furthermore, the e-mail, calendar and other items on the mobile device are 
synchronized with respect to the time span for which items should be shown 
according to the settings. This is called the synchronization window. For instance, 
the settings may specify that the e-mail application should show e-mails for the 
last 7 days. The sync process will then clear e-mails older than 7 days from the 
Inbox and other mailboxes except Drafts (on the mobile device only). 

2 Have any items been deleted? If an item, for instance a meeting, has been deleted 
in the collaboration system, the deletion will be reflected on the mobile device. 
Note that e-mails deleted on the mobile device will not be deleted on the 
collaboration system, if the setting Delete only locally is enabled. Note also that 
you will not receive notification of changes when e-mails are deleted from the 
server. 

3 Have any items been edited? If you for instance edit a contact on the mobile 
device or on the collaboration system, the change will be synchronized. In the 
same way, if you edit a spreadsheet on the mobile device, the sync process will 
update the spreadsheet on the DME server if file sync. is enabled. 
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Conflicts 
In some cases, a conflict may arise. For instance, if a meeting has been moved to 
another time on both the collaboration system and the mobile device, DME will 
resolve the conflict by moving the meeting to the time indicated in the DME client, 
and a message will be sent to you with information about this fact. 
Also, during the initial synchronization of the client or during a subsequent reset, 
duplicate contacts or calendar items may occur. In this case, the duplicate entries will 
be created, and an e-mail listing the duplicate entries will be sent to you (using DME 
3.6). 
 

Synchronization methods 
The DME client can be synchronized in four ways: 
1 Server-initiated sync. (Push) 

Whenever someone sends you an e-mail, a meeting invitation, or similar, it is 
received by the collaboration system. The DME server constantly checks for such 
updates in the collaboration system, and sends a notification by network push, 
Apple Push, or as an SMS (a text message) to the mobile device on which your 
DME client is installed. The notification is picked up, read, and (in the case of 
SMS push) deleted by the DME client, and a sync is initiated to make the device 
reflect the change in the collaboration system. The DME client will optionally 
notify you with a sound whenever a new e-mail has arrived in this way. Push sync 
is enabled and scheduled by the DME administrator. Notifications can also be sent 
in case system settings are updated or a server command is issued. 
Note that notifications may be disabled on the server, and that they may disabled if 
the device is roaming (see Roaming). 

2 Scheduled sync. 
The client can be set up to synchronize at regular intervals. When synchronizing, 
all enabled resources are synchronized - that is, if the Sync. option for the resource 
in question (for instance To-do sync.) is enabled. The scheduled sync intervals are 
the same for all resources. 

3 Pull sync. 
For e-mail and calendar items, you can set up a separate schedule for 
synchronization. This way you can for example set up scheduled sync intervals for 
contacts, to-dos, and files, disable scheduled sync for e-mail and calendar, and 
enable pull sync for e-mail and calendar with a more frequent schedule. 

4 Manual sync. 
Finally, it is possible to synchronize the client with the server manually by 
selecting a menu item in the client. You can synchronize the different resource 
types individually, or you can choose to sync all resources at the same time. 

During the synchronization operation, the DME client shows a status messages about 
the current sync process in the interface. In order to optimize speed and bandwidth 
consumption, the DME server builds a list of commands to be executed by the client 
the next time it connects with the server. This is called a "command stack". When the 
client connects with the server, for instance in order to synchronize e-mail, the server 
will force the execution of those commands on the client. For this reason you may 
experience that, for instance, the e-mail sync you requested is followed by a calendar 
sync - meaning that the server takes the opportunity to update your calendar because a 
change has occurred. 
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While the synchronization is in progress, you can cancel it by selecting Synchronize > 
Cancel sync. from the DME menu. 

 
 

Initial import and reset 
The first time you log in to the DME after installing the client, DME will receive a set 
of default client settings from the server. Based on these settings, DME will import 
data from the server into the enabled data stores. For instance, if you have enabled 
e-mail sync. and calendar sync., DME will immediately and silently import your 
e-mails and calendar items from the server. This is called the initial synchronization. 
Your DME administrator has made two important choices which affect your initial 
synchronization: The DME settings for Calendar/Contacts mode and Action to 
perform on client upon initial import.  
 If your DME administrator has selected Wipe as initial import action, and your 

calendar and/or contacts are set to Open mode, all calendar items and contacts 
that existed on the device before you installed DME are deleted before they are 
imported from your collaboration system mailbox. If you have calendar items and 
contacts that do not exist in your collaboration system also, and you want to keep 
these, you must synchronize them with another system first. 

 If the DME administrator selected Merge as initial import action, and your 
calendar and/or contacts are set to Open mode, DME will send all your calendar 
items and contacts to the server. DME will then add those calendar items and 
contacts that do not already exist on the collaboration system to your collaboration 
system calendar and address book. DME runs an extensive duplicate control to 
weed out duplicates. This is not too hard to do for calendar entries, but requires 
careful analysis (and thus time) for contacts. 

If your calendar and/or contacts are set to Secure mode, DME will not touch your 
local calendar or contacts, regardless of the Action to perform on client upon initial 
import setting. The import or reset only affects the stuff that DME is actually 
handling. 
If you enable the synchronization of another resource after the initial synchronization, 
for instance Contacts, then the initial synchronization of this resource will actually be 
an import.  
This Reset function corresponds to an initial synchronization. If you think that any of 
the resources on your phone are out of sync, you can reset the DME data on your 
phone by choosing Tools > Reset in the DME menu. This will perform an import of 
all resources according to the rules outlined above. 
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Note that the DME administrator can also force an import of items on your device. In 
this case, you will not be asked if you want to keep the original entries; the device will 
simply start effecting the command and replace from server. 
In the case of contacts in Open mode, you may need to add device specific features to 
the contacts, such as photos, speed dial keys, etc. after a reset. These settings will not 
be lost when you synchronize contacts with the server (but they will after a reset). 
See also Flexible field mapping on page 13 below for more information about 
contacts. 
 

Flexible field mapping 
It is possible to create custom mappings between fields in Domino or Exchange and 
contacts on the device. You can use this feature for enforcing company policies. 
For instance, you may have a policy of always calling the internal office number when 
calling a colleague in order to cut costs. You can then decide to add the internal office 
number to the "Pager" field in Notes, and map the Pager field to the "Telephone 
(business)" field on all devices. 
Custom mapping should be carefully planned, and can only be set up in cooperation 
with a certified DME partner. Partners may request special documentation from 
Excitor A/S. 
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User guide: Windows Mobile 
devices 
DME supports a wide range of Windows Mobile devices running Microsoft Windows 
Mobile 5 or 6. For a list of supported devices, please see the Supported Devices - 
Symbian 
http://www.excitor.com/Default.aspx?id=47&device_search=Symbian&device_sortb
y=product_group page at the Excitor website. 
The models used throughout this manual for illustration purposes are the Qtek S200 
(HTC PM300) Pocket PC running Windows Mobile 5, and the HTC Touch HD, 
running Windows Mobile 6.5: 

 
 

Installing DME on Windows Mobile 
 

OMA DM installation 
Installing using DM requires that the device is bootstrapped. When the device is being 
bootstrapped, you must confirm a DM Service Message by entering a PIN code: 
12345 by default. After this, the installation and subsequent upgrades of DME through 
OMA DM is completely transparent. The DME client seems to suddenly appear on the 
device, prompting for login information. 
Note that OMA DM is not supported on all Windows Mobile devices. 
Push installation 
When the DME Administrator has "pushed" DME to your phone (as opposed to 
installing using OMA DM), you will receive an SMS or a WAP Service Message with 
the text DME Software Installation and a link. 
1 Open the message. 
2 Click the highlighted link (WAP Service Message), or 

Scroll to the link (SMS), click, and choose Open link. 
3 A web browser opens, and you are prompted to download the DME installer 

(possibly you must accept a browser security warning first). 
You may observe a second SMS from the DME server in your Messaging Inbox - this 
is the server path, which is sent to the device immediately after the SMS or Service 
Message containing the download link. The server path message is deleted by DME as 
soon as you log in for the first time. 
 

http://www.excitor.com/Default.aspx?id=47&device_search=Symbian&device_sortby=product_group
http://www.excitor.com/Default.aspx?id=47&device_search=Symbian&device_sortby=product_group
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Starting the DME client 
The DME client will usually be set up to launch automatically when you start the 
device. DME contains a number of security features that depend on the client being 
started. Furthermore, the client contains a feature that makes it impossible to shut 
down the client without also shutting down the device. For more information, see 
Data security on page 7. 
If the DME client does not start automatically, do the following to start it. 

 Starting the DME client 
1 Tap Start. 
2 Tap Programs. 
3 Open DME Secure E-mail. 

 
If the client is already running, you can switch to the client using the task manager or 
the Today screen (Pocket PC) or home screen (Smartphone). 
When the DME client is installed, it is automatically added to the Today screen, so 
that information about the time of last sync with the server and the number of unread 
e-mails is displayed: 

 
Depending on your Today screen setup and your current Calendar mode, up-coming 
calendar events are also shown. See Calendar settings on page 72. 
On Smartphones, you must add DME to the Home screen plugin manually by 
selecting an option in General settings (see General settings on page 66). 
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If DME is for some reason not shown in the Today screen on your Pocket PC, you can 
set it up by opening the Today application in the Settings program group. Tap the 
Items tab, and select the DME check box: 

 
Tap OK, and exit the Settings program group to see the Today screen including the 
DME item. 
 

Logging in 
When the DME client is launched, the login window is shown: 

 
You must log in with the same user name and password that you would use for the 
collaboration system on your desktop PC. For Lotus Domino users, this is your 
"Internet password". Contact your IT department if you have problems with your user 
name or password. 
If the DME client was already running, and you are logging in again after logging out 
(either manually or automatically after a period of inactivity), the screen shows the 
time of the last synchronization with the collaboration system and the number of new 
e-mails. 
The client remembers the user name from your last login, unless the DME 
administrator has disabled this feature for security reasons. 
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If you have defined a PIN code, you may log in using that rather than your LDAP 
password. See Logging in using a PIN code. 
 

First-time login 
If you are logging in to the client for the first time, the login process is different. When 
you start the client, the login screen is shown, but without the indication of last 
connection and number of new e-mails. 

 
 Logging in to DME for the first time 

1 Login: Enter your user name and password, and select Login. Lotus Notes users 
should note that this is your "Internet password" (the same as for your webmail).  
Since this is the first time you enter your user credentials, DME needs to make a 
connection to the server to verify that your user name and password match, so the 
first-time login takes a little longer than subsequent logins. DME stores your 
password in multi-hashed, encrypted form (that is, very secure) on the client. 
Therefore, the next time you log in to the client, you do not need to make a server 
connection to verify your login. However, when you do make a connection (for 
instance when you synchronize e-mail), your login credentials will be verified 
again. 

2 Server path: If the installation file was pushed to your device from the server, the 
server path is sent to the device along with the installation file, in a separate SMS. 
When DME launches, the server path is read from that SMS. 
If DME was installed through OMA DM, the server path is included in the 
installation instructions, and you need not supply the path.  
If DME was installed in another way, for instance through cable transfer, you must 
enter the server path here. The server path has the form 
https://dme.yourcompany.com:5011, where dme.yourcompany.com is 
the name of the server where DME is installed, and :5011 is the port number. 
In case you lose the path to the server, contact the DME administrator. He or she 
can send the server path to your device using the Send server path function in the 
Devices tab in the Web Administration Interface. Alternatively, you can enter the 
following in the Username field: SERVERPATH, and then press Login. This lets 
you specify the Internet address of the DME server. Press OK, restart DME, and 
confirm the new path. 
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3 Certificate: If this is the first time DME was ever installed on this phone, you 
may be asked to accept the installation of a certificate, if your company uses the 
DME self-signed certificate. You must select Yes to continue. 

4 If the login process is successful (that is, DME can establish a connection to the 
DME server and log in using your user name and password), you are prompted 
whether you want to import your e-mail at this point. 

 
This is a good idea after your first login. See Initial import and reset on page 12 
for more information. 

You are now ready to use the DME client. 
 

Removing the client 
Uninstalling the client from a device follows the usual procedures for each platform. 
The DME administrator may have specified on the server that you are never allowed 
to uninstall the client. In this case, you are unable to do so. 
Alternatively, the DME administrator may specify that you are only permitted to 
uninstall the client if you are logged in. In this case, you will be prompted for a user 
name and password when you attempt to uninstall the client. If you enter the correct 
credentials within one minute, you will be permitted to continue uninstalling the 
client. 

 Uninstalling the DME client for Windows Mobile 
1 Tap Start. 
2 Tap Settings > System. 
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3 Tap Remove Programs. 

 
4 Select Excitor DME Secure E-mail, and click Remove. 
The DME client is then removed from the device. 
 

The DME Desktop 
The main DME screen is the Desktop. The Desktop gives you quick access to the most 
commonly used features in DME. 

 
Use the navigation keys to move to the different icons. Moving past the last icon on 
the screen moves focus back to the top. Click the center navigation key to run the 
function associated with the icon. 
 

Desktop actions 
The following is a brief explanation of each Desktop icon, with references to more 
information: 

 
Go to the Inbox (see Navigating the folder tree on page 22) 

 
Go to the Unread folder (see Navigating the folder tree on page 22) 

 
Open the Folders screen (see Navigating the folder tree on page 22) 

 
Create a new e-mail (see Creating and sending e-mails on page 31) 
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Open the internal DME Calendar (see Calendar on page 43) 

 
Create a new meeting invitation (see Booking meetings on page 50) 

 
Synchronize e-mail (see Synchronization overview on page 10) 

 
Open the Search menu (see Search on page 38) 

 
Open the Settings page (see Settings on page 66) 

 
Go to the Contacts application (see Contacts on page 54) (not Java 
devices) 

 
(Symbian devices only) Open the SmartEncrypt on-the-fly encryption 
application (see the SmartEncrypt Quick Guide) 

 
(Some Nokia S60 devices only) Open the VoiceExtender™ call 
answering machine (see the VoiceExtender™ Quick Guide) 

Apart from these icons, you can use the DME menu (Options) to access all functions 
in DME. You can access the DME menu from all views in DME. For an overview of 
the DME menu, see Menu tree on page 77. 
For information about how to configure your Desktop, see Desktop settings on page 
77. 
 

Shortcuts 
To quickly access the most common features in DME, you can press a keyboard 
shortcut. By default, the following shortcuts have been defined in DME: 

Press... ...to execute the following action 
*0 <Not defined by default> 

*1 Synchronize e-mail 

*2 Mark as read 

*3 Mark as unread 

*4 Create a new e-mail 

*5 View folders 

*6 Open the DME calendar 

*7 Create a new meeting 

*8 <Not defined by default> 

*9 Open the Contacts application 
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To access the shortcut actions, press * followed by one of the keys 0-9. Note that in order to 
press *, you need to press a modifier key first - Shift or Fn. When you have pressed *, DME 
shows a list of the currently defined shortcuts: 

 
Now press the number of the shortcut action you need - for instance 5 to open the 
Folders view. 
Shortcuts can be used whenever the cursor is not inside an editable field (in an 
editable field, the shortcut keys will simply be inserted as regular characters). 
You can change the definition of shortcuts to better suit the way you use DME. For 
more information, see Shortcuts settings on page 76. 
 

Working with folders 
The DME mailbox consists of at least the following folders: Inbox, Outbox, Drafts, 
Sent, and Unread. The first four of these folders function as the corresponding folders 
on the collaboration system (Notes or Outlook). The Unread folder is a smart folder 
which shows all unread messages in any folder in the DME client. When an e-mail in 
the Unread folder is read, it disappears from view - but naturally remains in the folder 
from which it originated. 
Apart from these standard folders, subfolders created on the collaboration system 
(Notes or Outlook) can be shown on the client. Subfolders from the collaboration 
system can be shown if the folder synchronization feature is enabled on the DME 
server and on the client (see Folders settings). If enabled, you have access to all the 
e-mail folders on your collaboration system. With settings similar to the e-mail 
settings (see E-mail settings) you can specify how many e-mails you want to see in 
each folder (by age in days) and whether you want to synchronize e-mails in folders at 
all. This is specified as a system-wide setting. In the following section you can see 
how to specify different settings for each folder, including whether you want to 
receive a notification when a new e-mail arrives in a folder. 
 

Navigating the folder tree 

To move between folders, tap the desktop Folder icon , or select View > Folders 
in the DME menu (or press *5). From a mailbox, you can tap the mailbox icon in the 
top left corner of the mailbox view (for instance the Inbox icon). When you do this, 
DME shows a list of all folders in the system. You can then move to the desired folder 
using the navigation keys, and click the center navigation key to open the folder in 
mailbox view. 
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Notice the following in the folder selection screen: 

 
1 When a folder contains subfolders, it looks like this: . Tap the plus icon to the 

left of the folder to expand the folder, or press the Right navigation key. To 
collapse the folder again, tap the minus icon, or press the Left navigation key. 
To navigate to the subfolders, tap the folder, or press the Down navigation key. 

2 Folders that you have chosen to keep synchronized are shown with a 
synchronization symbol: . 

3 If the plus sign on a folder is grey like this:  it means that it cannot be selected. 
On Domino systems, you can create folders and subfolders at the same time by 
naming a new folder like this: Work\Testing. When created in this way, the parent 
folder (Work) cannot itself contain e-mails (but Testing can). Therefore you cannot 
select the parent folder here, but you can navigate to the subfolder by pressing the 
Right navigation key. 

To select a folder, tap it, or use the navigation keys to move to the folder you want to 
see, and press the navigation key. The folder is shown in mailbox view. Choose 
Cancel in the DME menu to return to the mailbox you opened the Folder view from. 
 

Setting folder options 
You can set defaults for the way e-mail folders should be synchronized between 
collaboration system and client (see Folders settings). If you have many folders on the 
collaboration system, it is recommended that you set up very restrictive default 
settings for performance reasons, and loosen up on individual folders as described 
below. 
To change synchronization options for a folder, open the folder view described in the 
previous section, browse to the folder you want to customize, and select Settings in 
the DME menu. The following screen is shown: 
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 Use default values 
If this field is set to Yes, the current folder uses the general settings specified (see 
Folders settings). If Apply to subfolders is also selected, the default settings will 
be applied to all subfolders below the current folder as well, when you press Done. 
If the value in this field was No, and you change it to Yes, the settings in the 
remaining fields in this screen will be reset to the default values when you press 
Done. 
If you want to apply other settings than the default settings to this folder, you must 
select No in this field. 

 Sync. folder 
This option can only be changed if Use default values above is set to No. If this 
field is set to Enabled, e-mails in the current folder are synchronized with the 
collaboration system, using the synchronization window defined in the field Days 
back below. To avoid too high load on the DME server, you should only 
synchronize those e-mail folders that you really need on the device. You can for 
example consider to not synchronize folders containing graphics-intensive 
newsletters etc. Synchronized folders are shown with an icon like this: . 

 Include in mail scan 
This option can only be changed if Use default values above is set to No. If this 
field is set to Enabled, you will receive notification when a new e-mail arrives in 
the current folder. New e-mail can "arrive in" subfolders by means of rules, which 
are set up on the collaboration system to automatically distribute new e-mails in 
folders. 

 Days back 
This option can only be changed if Use default values above is set to No. When 
e-mails are synchronized, e-mails from the last number of days selected here will 
be synchronized and available in the current folder. 

 Apply to subfolders 
If this field is set to Yes, the settings made in other fields in this screen are 
propagated to folders below the current folder when you press Done. Use this 
function with caution, as the setting may affect many folders. Note that you can 
choose this option regardless of the value of the field Use default values above. 

Instead of synchronizing e-mail to the client, you can use the Search e-mail (on 
server) function to find e-mails in any folder on the collaboration system. See E-mails 
(on server) on page 40 for more information. 
 

E-mail 
Tap the  icon from the Desktop (DME menu: View > Folders > Inbox) to open 
the Inbox, which displays the e-mails and meeting invitations that have been 
synchronized or pushed to the client. 
Tap the folder icon at the top left of the mailbox to browse through the available 
folders: Inbox – Outbox – Drafts – Sent – Unread. 
If folder synchronization is enabled on the server, you can access all your mailbox 
folders by selecting View > Folders in the DME menu (see Working with folders on 
page 22). Through the View option you can also access the calendar and your 
contacts. 
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Above the e-mail list you can see the total number of e-mails in the current folder. In 
the Inbox, the number of unread e-mails is shown in parentheses. The number of 
unsent e-mails in the Outbox (if any) is shown to the right in all the other mailbox 
folders after the Outbox symbol . 
If your company uses the IBM Sametime instant messaging (IM) application, you can 
choose to view the Sametime status of your Sametime contacts in the mailbox folders 
(see General settings on page 66). If you do this, a symbol next to the name of the 
sender of an e-mail in a mailbox indicates his or her Sametime status: Away , In a 
meeting , Do not disturb , or Available . 
The illustration below shows the main DME mailbox interface. 

 
Use the scroll key to navigate through the user interface. 
 

E-mail icons 
On the left side of of each e-mail in the mailbox view, an e-mail icon is displayed. The 
icon tells you quite a bit about the e-mail at a glance: 

 An unread e-mail is shown as an unopened envelope. The sender is displayed in 
a boldface font. 

 An already read e-mail is shown as an opened envelope. 
In addition to this, different symbols can be superimposed on the e-mail envelope, 
providing you with more information: 

Symbol Meaning 

 
This e-mail has been replied to. 

 
This e-mail has been forwarded. 

 
This e-mail contains one or more attachments. 

 
This e-mail is a meeting invitation. 

 
This e-mail has high priority. 

 This e-mail has been marked for follow-up. 

 
This e-mail is encrypted. 
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This e-mail is signed. 

The Replied to and Forwarded status are synchronized with the server. If, for 
instance, you reply to an e-mail from your device, then your mailbox in Outlook or 
Notes will also show that you have replied to the e-mail. 

 An e-mail in the Drafts folder. 

 An e-mail in the Sent folder. The e-mail icon in both the Drafts and the Sent 
folders can be superimposed by the attachment, priority, encryption, or signature 
symbols. 
 

Reading e-mails 
To open an e-mail, select the e-mail in a folder, and press the navigation key (or tap 
the e-mail). 
Scroll through the e-mail by using the navigation keys or dragging the scroll bar. 
If you click the navigation key while scrolling through the e-mail body, the e-mail 
body will be shown in full screen. To leave full screen mode, press the OK soft key. 
Note that link detection (see below) is not available in full screen mode. 
You can open the next unread e-mail by choosing Show next unread e-mail from the 
DME menu in the open e-mail. 
 

Links 
When scrolling through e-mails, the DME client will search for different links such as 
e-mail addresses, phone numbers, and web links. Whenever a link is found, it is 
highlighted. A number of options for the link are shown when you select Advanced 
options in the DME menu. 
For e-mail addresses and phone numbers, you can select the following options. 
 Call (or simply press the green Call key ): If the highlighted text is a phone 

number, the Call option will dial the number. If the field is an e-mail address, the 
Call option will look up contacts with the e-mail address in question and present 
the phone number(s) of the found contact, allowing you to make a call to the 
contact. Press OK to call the selected phone number. 

 Add to contacts: The highlighted text is copied to the clipboard, a new contact is 
created in your Local contacts, and the text is pasted to an appropriate field. If the 
number or e-mail address already exists, DME will ask if you want to update the 
existing contact. 

 Edit contact: DME tries to find the contact in your Local contacts with the 
highlighted phone number or e-mail address. If found, DME opens it, allowing 
you to edit the contact. If not found, DME lets you search for a contact. 

 Send e-mail to contact: If the highlighted field is an e-mail address, this option 
will create a new e-mail for the address. If the field is a phone number, this option 
will look up contacts with the number in question and present the e-mail 
address(es) of the found contact, allowing you to create an e-mail for the selected 
address. 

When a web address is highlighted, you can select Open Web address in the menu to 
open the link in the built-in browser. 
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SmartLinks 
SmartLinks are links in the body text of e-mails, which are handled in a special way 
by the DME client and the DME server. SmartLinks may for instance link to Word 
documents, PDF files, or other binary files that are only available on, say, the 
corporate intranet. Such files are not usually available from outside the corporate 
network (without using a VPN connection). However, when you select the SmartLink, 
the DME client is able to download the file as if it were an attachment in the e-mail. 
The use of SmartLinks requires the DME administrator to set up the DME server in 
such a way that the DME client recognizes certain links in the mail body text as 
special links. As described in the previous section, DME automatically highlights web 
links - that is, links starting with http: or https: or www. If any such link contains the 
text defined on the DME server, the link will be treated in a special way - instead of 
opening a browser window, the client will send a request to the DME server, which 
will then prompt the client to log in and download the requested file (if it exists). You 
can say that the server acts as a proxy. 

 

 
Example: the body text of an e-mail contains two links: 
1 http://www.example.com/onepagedown 

Selecting this link will open the built-in browser and go the onepagedown page at 
www.example.com. This is a normal web link. 

2 http://intranet.example.com/doc?id=234 
Provided that http://intranet.example.com has been defined as a SmartLink site on 
the DME server, selecting this link issues a request to the DME server to 
download the document defined by the document ID 234. 

The downloaded file is opened by the associated viewer immediately. When you close 
the viewer, the file is deleted from the device. 
Please note that the SmartLink functionality is an add-on to DME, and special 
documentation concerning how to set up this feature is available. 
 

Attachments 
When you receive an e-mail with an attachment, you will see an attachment icon  in 
the mailbox. 
Graphics that have been embedded into an e-mail may be shown as attachments on the 
client. This requires DME server version 2.0 and above and that you run Domino as 
your collaboration system. 
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 Opening an attachment 
1 Open the e-mail. 
2 Select Attachments in the DME menu. 

A list of the attachments to the e-mail is displayed. 

 
3 Select the attachment. 
4 Select Yes to download and open the attachment. 

DME connects to the server. 
5 Select Yes to allow the attachment to be decrypted to disk. 

The attachment file is stored in a temporary folder on the device disk, which is 
outside the secure DME area. It is deleted from the temporary folder again when 
you log out of DME. If DME cannot delete the attachment immediately when you 
log out, for instance if it is still open in the application, it will keep trying at 
regular intervals. 

To save transmission time and space on the device, attachments are not stored on the 
device unless you specifically choose to download them. In the attachment list, the  
icon shows if the attachment is only located on the mail system server. A 
phone-and-clip icon  means that the attachment has been downloaded to the device. 
The device supports several types of attachments depending on the programs installed. 
By default, the device will recognize several types of image files such as .bmp and 
.jpeg, sound files such as .wav, and text files. Usually the device will also be able to 
open Microsoft Office and Adobe PDF files. Please refer to the user manual of the 
device for further information.  
If the file does not have a file type association, an error message will be displayed, and 
the file will not be downloaded. If you have a program that you know will open the 
file of the type in question, you must set up a file association to that file type, and try 
to download the attachment again. For information about file associations, see your 
mobile phone documentation or the documentation for your mobile phone operating 
system. 
Apart from opening the attachment, you can  
 Save the attachment on the device. 
 Send the attachment via Bluetooth or other medium supported by your device (see 

Sending an attachment on page 29). 
 Delete the attachment from the temporary folder on the device (see Removing 

attachments on page 29). 
 Download all listed attachments to the device. 
Note that the DME administrator may have disallowed the download of attachments 
for security reasons. 
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Sending an attachment 
When an attachment has been downloaded to the device, you can use the device to 
send the attachment to an external source. 

 Sending an attachment (not by e-mail) 
1 Open the e-mail that contains the attachment. 
2 Open the DME menu, and select Attachments. 
3 Select the attachment. 
4 If the attachment has not been downloaded to the device (indicated by an  

icon), you must choose to open the attachment first. 
5 Open the DME menu, and select Send to (or Send). 
6 Select the method by which you want to send the attachment (see below). 

Sometimes only one option is available, for instance Bluetooth, and the device will 
start the detection or transfer immediately. 

Follow the instructions from the device manual on how use the specified send method. 

Send method Description 
Via multimedia Creates a multimedia message (MMS) with the selected 

attachment. 

Via e-mail Creates an e-mail with the selected attachment using the 
built-in, usually POP3-based, e-mail program. 

Via Bluetooth Sends the selected attachment via a Bluetooth connection to 
another device or computer. 

Via infrared Sends the selected attachment via an infrared connection to 
another device or computer. 

 
 

Removing attachments 
When you download attachments to the device, the attachments will take up space on 
the device. To free this space, you have the option to remove downloaded files from 
the device. The attachments will not be deleted on the mail system, only on the DME 
client. 

 Removing a single attachment 
1 Open the e-mail containing the attachment. 
2 Open the DME menu, and select Attachments. 
3 Highlight the attachment. 
4 Open the DME menu, and select Remove from phone (or press the Delete key on 

your device). This option is only shown if the attachment has in fact been 
downloaded to the device (indicated by ). 

5 Press Yes to confirm. 

 Removing all attachments from the device 
1 Go to the mailbox view of any folder. 
2 Open the DME menu, and select Actions > Delete all attachments. 
3 Press Yes to confirm. 
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Viewing e-mail details 
You can see a summary of information about the e-mail you are reading. 

 Viewing e-mail details 
1 Open an e-mail. 
2 Open the DME menu, and select E-mail details. 
An information box shows information about the current e-mail. 
The information consists of details about the sender, the date and time the e-mail was 
sent, and a list of recipients of the e-mail (individual recipients or a mail group). 
 

Calling the sender 
You sometimes find yourself needing to call a person from whom you have received 
an e-mail. In DME, you can use the green call key  to place a call to the owner 
associated with any selected e-mail address. 

 Calling a number associated with an e-mail 
 In any mailbox folder, you can scroll to an e-mail from (or to, in the case of the 

Sent folder) the person whom you want to call. Press the green call key. 
 If you are reading an e-mail, you can move to the sender field and press the green 

call key. 
or 

 If an e-mail address in the e-mail is highlighted as a link (see Links on page 26). 
In all cases, DME searches your local address book for a contact with the specified 
e-mail address. The outcome of this search can vary, and DME will act according to 
the result in the following ways: 
 The selected e-mail address is found in your local address book: 

The phone will dial the number of the associated contact. 
 The selected e-mail address is found in your local address book, but more 

than one phone number is associated with the contact: 
DME shows a list of the associated numbers. Scroll to select one number, which is 
then dialed. Note that a default number may have been specified by the DME 
administrator. The administrator can for instance specify that the number stored in 
the Fax (business) field of your contact should be the default number, because 
company policy specifies that a cost-saving short number should be stored in that 
field. The default number will be pre-selected in the list of numbers shown. 
On devices that support a default number feature in their local Contacts (most 
Symbian devices do), the administrator-enforced default number will be set as 
default on all contacts. This means that phoning a contact from the native 
phonebook application will dial the Fax (business) number immediately (to 
continue with the previous example). 

 Multiple contacts in the local address book are registered with the selected 
e-mail address: 
DME shows a list of the names of the contacts having the e-mail address in 
question. Scroll to select a name, which is then dialed immediately if only one 
number is registered for that contact; otherwise a list of the phone numbers of the 
contact in question is shown. 
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 The selected e-mail address is not found in your local address book: 
DME asks for permission to search the the Global Address Book. If you accept 
this, the search screen is opened, and the selected e-mail address is inserted in the 
E-mail field. You can now search for the e-mail address in the Global Address 
Book. When you receive the search result, press the green call button on any of the 
found persons to place a call to that person. The default number feature (see 
above) applies to Global Address Book searches as well. See Global Address 
Book on page 39. 

 

Other e-mail options 
Apart from the options concerning attachments and e-mail details mentioned above, 
you can open the DME menu for more options: 
 Quick reply / Reply / Reply to All 

Create a reply to the e-mail - see Replying to e-mails on page 35. 
 Move to folder 

If folder synchronization is enabled, you can use this option to open the folder 
selection view (see Navigating the folder tree on page 22). Pick a folder, and 
select OK to move the current e-mail to the folder in question. 

 Forward 
You can forward the e-mail - see Forwarding e-mails on page 35. 

 Delete 
Delete the current e-mail. You can do this by pressing the Delete button as well. 

 Advanced options 
In this menu, two options are shown (more, if a link is selected - see Links on page 
26): 
 Copy to 'Book meeting' 

If you select this option, the currently open e-mail is converted to a new 
meeting invitation. The e-mail subject is used as meeting subject, and the 
e-mail body is used as meeting description. For more information, see 
Booking meetings on page 50. 

 Copy to task 
If you select this option, the currently open e-mail is converted to a new task in 
the Windows Mobile Tasks application. The e-mail subject is used as task 
heading, and the e-mail body is used as task description. 

 Show next unread e-mail 
Close the current e-mail, and show the next (newer) e-mail that has not been read 
yet. 

 Call 
Corresponds to pressing the green call key . See Calling the sender above. 

 

Creating and sending e-mails 
 Creating and sending an e-mail 

1 Select Create > E-mail from the DME menu almost anywhere in the DME client. 
or 

Click the New e-mail icon in the Desktop:  
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2 Enter message details as described in the next section - see E-mail details on page 
32. 

3 In the DME menu, select Send. 
The e-mail is now saved in the Outbox. Depending on the e-mail settings, the e-mail is 
sent immediately or queued for the next scheduled or manual synchronization (see  
E-mail settings). When the e-mail has been sent, it is moved to the Sent folder. 
Note that you can also create an e-mail by finding one or more e-mail addresses 
through the Global Address Book first, and then choosing to create an e-mail using the 
selected e-mail addresses. For more information, see Global Address Book on page 
39. 
 

E-mail details 
The e-mail form works like a normal e-mail with fields for Send to, Carbon Copy (CC), 
Blind Carbon Copy (BCC), Subject, and Body. If you need to type multiple recipients in 
a field, you can separate the recipients using a comma (Lotus Notes style) or a 
semicolon (Outlook style). 

Tip: Some collaboration systems are able to resolve names of known users. This 
means that you only have to enter the short name as the e-mail recipient. For instance, 
you could just enter sad in the Send to field, and the collaboration system would 
resolve (expand) the name to Sabine.Adelhof@excitor.com automatically. Ask your 
DME administrator if this is possible in your setup. 
Tip: For devices without a full keyboard, you can insert a new line in the e-mail body 
by pressing the center or right scroll key (depending on device model). 
 

Entering recipients 
With the cursor placed in the Send to ( ), CC ( ), or BCC ( ) field, you can start 
typing the name of a recipient. DME will try to predict who you want to enter as a 
recipient, and shows suggestions in a drop-down list below the recipient field: 

 
As you use DME, DME builds a history database of e-mail recipients. This database 
consists of the 200 most recently used e-mail addresses, gleaned from your Inbox and 
Sent mailboxes, from participants in meetings where you are a participant or chair, 
and from your local contacts. DME uses this information for generating the 
drop-down list dynamically, according to the following principles: 
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 If you press the scroll key in the field without typing anything, a list of the five 
most recently used recipients is displayed, along with a link to the local contacts 
and the Global Address Book. 

 If you start typing, DME will match the typed characters with the names and 
e-mail addresses in the history database. For instance, typing a "c" will match the 
following entries in the database: 
 "Chris Rea <chris.rea@music.com>" 
 "Hooray Carlton <hooray@freude.de>" 
 "Melanie C. <melc@spice.com>" 
-but not "Martin Olsson <mols@corp.com>" even though both corp and com 
begin with a c - only the name part of e-mail addresses is searched, not the domain 
part. 
Links to the local contacts and the Global Address Book are also shown. 

As you type more characters, the list will grow shorter. In the example above, typing 
an "a" after the initial "c" will limit the list to "Hooray Carlton <hooray@freude.de>" 
only.  
Use the scroll key to move down the list. As you highlight the different choices, the 
highlighted name and e-mail address will scroll sideways to let you see the full length 
of the text, if it is too long to be shown in the list. 
When displaying search results in the list, DME ranks them in the following order: 
1 E-mail addresses found among the most recently sent items. 
2 E-mail addresses found among the most recently received items. 
3 E-mail addresses found among the local contacts. 
With regard to the local contacts, please note that DME adds contacts to the history 
database during the synchronization process. This means that if you add a contact on 
your phone, it will not appear in the list until after you have synchronized contacts 
with the server. 
Press the scroll key to insert the currently highlighted e-mail address in the recipient 
field. DME inserts a comma after the recipient, so you can immediately press the 
scroll key or start typing to insert another recipient. Press the right navigation key to 
close the list without selecting anything. 
Pressing Local contacts or Global Address Book lets you search the local or global 
address book, respectively. If you have entered any characters in the recipient field, 
they are transferred to the search field. For more information, see Address book 
integration see "Entering recipients" on page 32, on page 33 below. 
 

Address book integration 
If the cursor is placed in the Send to ( ), CC ( ), or BCC ( ) field, you can search 
for contacts in the Local contacts or the Global Address Book by pressing the 
navigation key or by beginning to type as described above. 
Local contacts are contacts stored on your device. This usually corresponds to your 
Personal Address Book on the collaboration system. Scroll and click to select the 
contact(s) you wish to send the e-mail to, and press OK. 
The DME menu in your Local contacts contains the following options: 
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 Cancel returns focus to the e-mail or meeting invitation you came from, ignoring 
any selected contacts. 

 Details lets you view and edit the selected contact. 
 Call dials the phone number associated with the currently highlighted contact. 

You can also press the green call key . If more than one number is associated 
with the contact, DME lets you choose from a list of the available numbers. 

The Global Address Book is the shared address book on the collaboration system. If 
you select this option, you can search for a contact by Name, E-mail address, 
Department, Country, and Title. For more information about how to select recipients 
using the global address book, see the procedure in Global Address Book on page 39. 
When you have selected the desired recipients, open the DME menu and select Done. 
The e-mail address of the contact(s) will be added to the field from which you started 
selecting recipients. If any of the recipients have multiple e-mail addresses, you will 
be able to choose between the addresses of each recipient. 
 

Saving as draft 
If you want to continue editing an e-mail at a later time, you can save the e-mail as a 
draft. 

 Saving an e-mail as a draft 
1 Open the DME menu, and select Save as draft. 

or 
2 Close the e-mail, and select Save as draft when asked. 
The e-mail is saved to the Drafts folder, and you are returned to the mailbox. When 
you want to finish the e-mail, you can open it from the Drafts folder, edit it, and send it 
in the usual way. 
 

Selecting message options 
You can sign, encrypt and mark the message with high importance. 

 Setting message options 
1 Open the DME menu in the e-mail you are creating, and select Message options. 
2 Scroll up/down to select an option. 
3 Click the navigation key to enable or disable the selected option. 
4 Select OK to set the options and return to the e-mail, or select Cancel to cancel 

your selections and return to the e-mail. 
Please note the following about signed and encrypted e-mail:  
 When you send a signed e-mail, and the DME server cannot find your private key 

on the server, an e-mail with a notification of the error "The DME Server could 
not send the signed S/MIME e-mail") is sent to you by the DME server. Your 
e-mail will be sent to the recipient; however, it will not be signed. 

 When you send an encrypted e-mail, the DME server needs to know the public 
key of each of the recipients of the e-mail. If the public key of one of the recipients 
is unknown to the server, an e-mail with a notification of the error ("Cannot find 
certificate for recipient: xx") is sent to you by the DME server. The e-mail will not 
be sent to any of the recipients. 

Using signed and encrypted e-mail requires special setup. Please contact your DME 
administrator. 
 



 35 
 

  User guide: Windows Mobile devices : E-mail  

Replying to e-mails 
When replying to an e-mail, you have the possibility to reply to sender with or without 
history (that is, with the original e-mail appended to the bottom of the e-mail) and 
reply to all with or without history. 
There are two ways of replying to an e-mail. 

 Replying to an e-mail 
1 Open the e-mail you want to reply to. 
2 Open the DME menu, and select Reply or Reply to All. 
3 Select With history or Without history. 

 Replying to an e-mail using Quick reply 
1 Open the e-mail you want to reply to. 
2 Open the DME menu, and select Quick reply. 

The functionality of selecting Quick reply is defined in the e-mail settings (see 
E-mail settings). Here you can specify if Quick reply should correspond to 
selecting To sender with history, To sender without history, To all with 
history, or To all without history. 

In both cases, a new e-mail is created for the original sender and possibly all original 
recipients. If the original e-mail contained attachments, you will be asked if you want 
to include the attachments in your reply. If the e-mail you are replying to was signed, 
encrypted, or marked with high priority, DME will copy these settings to the new 
e-mail. 
You can now add text and attachments to the e-mail and send it. See Sending 
attachments for information about how to work with attachments in e-mail replies. 
 

Forwarding e-mails 
You can forward an e-mail with all content, including attachments. 

 Forwarding an e-mail 
1 From any folder, open the e-mail. 
2 Open the DME menu, and select Forward. 
3 If the original e-mail contained attachments: 

Press Yes to include attachments, or 
Press No to send the e-mail without attachments 
See Sending attachments for information about how to work with attachments in 

forwarded e-mails. 
You can now add recipients, text and attachments, and select Send to send the e-mail. 
For information about how to enter recipients, see Entering recipients on page 32. 
If the e-mail you are forwarding was marked with high priority, DME will copy this 
setting to the new e-mail. 
 

Sending attachments 
You can include attachments in e-mails in two different ways: by forwarding an 
e-mail that already contains attachments, or by adding attachments from the device to 
new e-mails (either original e-mails, forwarded e-mails, or replies). Furthermore, you 
can add attachments to meeting invitations. 
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 Sending attachments in original e-mails and replies 
1 Create an e-mail (see Creating and sending e-mails on page 31 or Replying to 

e-mails on page 35). 
2 Select Attachments > Open in the DME menu. 
3 Select Add attachment in the DME menu. 
4 Browse to the file you want to add, and select Open. 

Repeat items 3-4 to add more attachments. After adding an attachment, you can 
remove the attachment from the e-mail again, or you can open the attachment. 

5 Press Close when you are done. 

  
 Sending attachments in forwarded e-mails 

1 Forward an e-mail (see Forwarding e-mails on page 35). 
2 You can add attachments in the same way as for original e-mails (see above). 

or 
If the original e-mail contained one or more attachments, and you chose to include 
the attachments in the forwarded e-mail, you can now manage the attachments. 

3 In the DME menu, select Attachments > Open to see the list of attachments that 
were included from the original e-mail. 

4 You can now select one or more attachments to remove them from the e-mail, 
open them, or you can add more attachments in the same way as for original 
e-mails (see above). 

Attachments in forwarded e-mails need not be downloaded to the device before they 
are sent. DME will pull the attachments from the collaboration system when the mail 
is sent, saving transfer costs. 

 Adding attachments to meeting invitations 
1 Create a meeting invitation (see Booking meetings on page 50). 
2 Add attachments in the same way as for original e-mails (see above). 
Note that the DME administrator may have blocked for adding new attachments from 
the device to e-mails. Furthermore, restrictions to the size of attachments apply. The 
default maximum size is 16MB, but this limit may have been increased or reduced by 
the DME administrator. 
 

Folder actions 
In each mailbox folder, you can perform a number of actions on one or more items. 
 



 37 
 

  User guide: Windows Mobile devices : E-mail  

Selecting multiple items 
To select several items in a folder or list, tap straight on their e-mail icon. The selected 
items are highlighted. Please note that you cannot select multiple items on 
Smartphone. 
 

Marking read/unread 
When you read an e-mail in the DME client, the e-mail will be marked as read - that 
is, the e-mail icon is open  and not closed . Furthermore, the e-mail will be 
marked as read in the collaboration system the next time you synchronize. You can 
mark an e-mail as unread after reading it, for instance in order to remember reading it 
when you get back to the office, or you can mark unread e-mails as read.  
The actions described below can apply to a number of selected items. See Selecting 
multiple items on page 37 for information about how to select multiple items. 

 Marking one, selected, or all e-mails as read or unread 
1 Open the DME menu, and select Actions. 
2 Select Mark read to mark the e-mail(s) as read, or 

Select Mark unread to mark the e-mail(s) as unread. 
3 Select Selected to mark the selected e-mail(s), or 

Select All to mark all e-mails. 
 

Toggle flag 
The actions described below can apply to one e-mail item or a number of selected 
items. See Selecting multiple items on page 37 for information about how to select 
multiple items. 

 Toggle the Follow-up flag for selected e-mail(s) 
1 Open the DME menu, and select Actions. 
2 Select Toggle flag (or Follow-up, depending on platform). 
A Follow-up flag is added to unflagged items, and removed from already flagged 
items.  

 
The follow-up flag is synchronized with the collaboration system - that is, the flag will 
show up in Outlook and Notes if you set it on the device, and vice versa. 
You can also select Actions > Toggle flag (or Options > Follow-up) from within an 
open e-mail. 
 

Sorting items 
You can sort items in the Inbox and the other folders ascending or descending by date, 
name, or subject. 

 Sorting items 
1 Open the DME menu, and select Actions 
2 Select Sort 
3 Choose between the following sort methods: 

Descending by date (newest e-mail at the top) 
Ascending by date (oldest e-mail at the top) 
Descending by name (by sender's name, Z-A) 
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Ascending by name (by sender's name, A-Z) 
Descending by subject (by e-mail subject, Z-A) 
Ascending by subject (by e-mail subject, A-Z) 

The selected sort order applies to all folders. 
The currently selected sort order appears disabled in the Sort menu, indicating which 
sort method is used. 
 

Deleting items 
When deleting an e-mail, the e-mail data is removed from the DME client. Depending 
on an e-mail setting, the e-mail can also be deleted on the mail system at the next 
sync. (see E-mail settings). 
The actions described below can apply to a number of selected items. See Selecting 
multiple items on page 37 for information about how to select multiple items. 

 Deleting one or more selected items 
1 Select the item or items to be deleted. 
2 Open the DME menu, and select Actions > Delete, or 

Press the Clear key. 
3 Press Yes to confirm the deletion. 
Note that DME will try to prevent the accidental deletion of many items. If you delete 
a large number of items (more than 20 e-mails/meeting invitations or more than 10 
contacts) at a time, a message will ask you if you really want to delete the items on the 
server, the next time the device synchronizes with the server. 

 Deleting the currently open e-mail 
1 Open the DME menu in the e-mail you are reading, and select Delete, or 

Press the Clear key. 
2 Press Yes to confirm the deletion. 
 

Moving items to other folders 
If folder synchronization is enabled, you can move e-mails between folders. The items 
are moved in the collaboration system as well at the next synchronization. 
The action described below can apply to a number of selected items. See Selecting 
multiple items on page 37 for information about how to select multiple items. 

 Moving an item to another folder 
1 Open the DME menu, and select Actions > Move to folder. 
2 The folder selection view is shown (see Navigating the folder tree on page 22).  
3 Browse to a folder, and click the navigation key to move the selected e-mail(s) to 

the folder in question. 
You cannot move e-mails to the Drafts, Sent, Outbox, or Unread folders. 
 

Search 
Using the DME client you can search for contacts in the global address book on the 
collaboration system, search e-mails in your mailbox on the collaboration system, or 
search e-mails already downloaded to the device. 
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Global Address Book 
The Global Address Book is the shared address book on the collaboration system as 
set up by the network administrators. 
To create an e-mail message or a meeting invitation, you can open the DME menu and 
select Create as described in Creating and sending e-mails on page 31 or Booking 
meetings on page 50. However, you can also find the recipient or recipients of your 
e-mail or meeting invitation first, and then choose to create a new e-mail or meeting 
invitation with the selected contacts as recipients (not all platforms yet). 

 Finding contacts in the global address book 
1 Open the DME menu, and select Search > Global Address Book (this step has 

already been completed if you open the global address book from a new e-mail or 
meeting invitation). 
You can now search for a contact by Name, E-mail address, Department, Country, 
or Title. 
Note that more fields or different fields may be available if the Global Address 
Book search screen has been customized. See separate documentation about 
customizing the fields in this screen. 

2 Enter a search text in at least one of the available fields, and select Search.  
A connection is made to the collaboration system, and the search results are 
displayed. Depending on a setting on the DME server, the search will either look 
for entries starting with the text you have entered, or entries containing the text 
you have entered. When searching for a name, you can enter both a first and last 
name separated with a space. 
By default a maximum of 10 results are shown, but this value can be changed by 
the DME administrator.  

3 From the search results, you can select contacts the same way as with your local 
contacts. Selected contacts are marked with a . 

4 If you opened the global address book search from an e-mail or meeting invitation, 
select Done from the DME menu to insert the selected contacts into the field from 
which you chose to search for contacts. 
or 
If you opened the global address book search from the Search menu, select 
Create > E-mail or Create > Meeting from the DME menu to insert the selected 
contacts as recipients in a new e-mail or meeting invitation, respectively. 

Apart from the Done or Create options, the DME menu contains the following 
options: 
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 New search: Return to the search screen with every option in the search screen 
reset to default values. (Note that this does not apply to the Windows Mobile 
client). 

 Select/Unselect: Select or unselect the currently highlighted contact. 
 Details: View more details about the selected contact. The type of details that can 

be seen depends on choices made by the administrator of the collaboration system. 
Select OK to close the details window. 

 Call: Any phone numbers associated with the highlighted contact are listed. Select 
one, and press OK to place a voice call with the contact, or Cancel to exit the 
menu. 

 Add to contacts: The details of the highlighted contact are copied to a new entry 
in your local contacts. You can edit the details and press Done to save the contact 
as a local contact. 

 

E-mails (on server) 
The DME client only synchronizes e-mails from the last number of days specified in 
the e-mail settings (see E-mail settings). This is called the e-mail synchronization 
window. Sometimes you may need to find an e-mail which is stored in a folder in your 
collaboration system mailbox which is not synchronized to the DME client, or which 
is too old to be synchronized to the client. 
Using this function, you can search for any e-mail stored in any folder of your mailbox 
on the collaboration system. 

 Searching for e-mails on the server 
1 Open the DME menu, and select Search - E-mails (on server) 
2 Complete the search fields in the form: 

1. Search text: In this field enter the text to search for. 
2. Field: Select the e-mail fields in which to search for the specified text. Click to 

choose between the following options: 
Any field: All text fields are searched for the specified text string. 
Subject: Only the Subject field is searched. 
Subject, Body: Both the Subject and the Body fields are searched. 

3. Person: In this field enter all or part of the name of the sender of the e-mail 
you are looking for (or recipient in case you are searching your Sent folder). 

4. Folder: Choose the folder in which the e-mails to be searched are located. 
Click to choose between the mail folders defined in the mailbox on the 
collaboration system. 
Select a folder, and choose Done. For information about folders and folder 
selection, please see Selecting folders on page 42 below. 

5. If you want to search in all subfolders to the selected folder, select the check 
box Search in subfolders. This can only be selected if your collaboration 
system is Microsoft Exchange. 

6. Date: If you select this check box, DME enables two fields in which you can 
enter a range of dates. This limits the search to e-mails received within the 
selected time frame. The time frame is by default today's date. You cannot 
choose a date in the future. 
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7. Results/page: In this field you can specify the number of results you wish to 
display per page. If your search generates a large number of results, it can take 
a considerable time to download all the results. Therefore you can define how 
many results you want to see at a time, and then browse to the next page of 
results. 

3 Select Search. 
Note that a search can only be executed if one or more of the fields Search text, 
Person, Folder, or Date has been completed. If not completed, an error message 
says "Search fields cannot be blank" when you select Search. 

The search results are displayed. Note that the client shows the results in the order in 
which they are presented by the collaboration system. If your collaboration system is 
based on Lotus Domino, the search results are returned in order of relevance. If your 
collaboration system is based on Microsoft Exchange, the search results are returned 
in chronological order (that is, by date). 
The server sets a limit to the number of search results. By default, the limit is 100 
results. The results are divided into a number of pages, depending on the number of 
results per page you have selected. If more results are returned than the specified 
number of results per page, DME shows the first page. To see the next page, press the 
scroll key to the right, or click the right selection key (or choose Next page in the 
menu). You are then prompted if you want to download the next pageful of results.  
Note that the results are cached on the device for as long as you are performing the 
search. This means that browsing between result pages is instantaneous once the 
results have been downloaded. 
If no results are found, DME shows a message that no matches are found, and you are 
returned to the search screen after confirming the message. 
DME initially only retrieves the header information from the e-mails, that is sender, 
date, and subject. If you click to open an e-mail, DME asks you if you wish to retrieve 
the rest of the e-mail. If you select Yes, the e-mail in question is downloaded from the 
collaboration system and stored on the device. 
On the search results page, the DME menu has the following options: 
 New search: Return to the search screen with every option in the search screen 

reset to default values. 
 Refine search: Return to the search screen, but retain the selections you already 

made. 
 Previous page: If more results were returned than the specified number of results 

per page, and you are not looking at the first page, you can go to the previous 
pageful of results. Alternatively, press the scroll key to the left or click the left 
selection key. 

 Next page: If more results were returned than the specified number of results per 
page, you can go to the next pageful of results. Alternatively, press the scroll key 
to the right or click the right selection key. 

Press Close (or Back on some devices) to close the search and return to the e-mail 
folder from which you opened the search window. 
Please note that for best performance, your mailbox should be indexed. For more 
information about indexing your mailbox, see the documentation for Lotus Notes or 
Microsoft Outlook. 
Note also that if you choose to search in a folder which contains other folders, you 
will get different results depending on your collaboration system:  
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 If you use Domino, the search for e-mails will be performed in the selected folder 
only. 

 If you use Exchange, a message will be shown: "Do you wish to include 
subfolders in your search?" If you answer Yes, e-mails in the subfolders of the 
selected folder will be searched as well. 

 

Selecting folders 
When you select the folder list button, you can see a list of the e-mail folders in your 
collaboration system mailbox. The list is in the form of a tree structure, where you can 
expand and collapse the tree and individual branches by tapping the plus and minus 
icons. If Folder synchronization is enabled (see Folders settings), you see all folders in 
your collaboration system mailbox. Otherwise, the first time you display this list, you 
can only choose among All folders, Inbox, Drafts, and Sent. However, you can display 
the actual mail folders in your mailbox on the collaboration system by opening the 
DME menu and selecting Update folders. 

 
The DME client communicates with the server and downloads a list of the mail folders 
you have defined in your mailbox on the collaboration system. See Navigating the 
folder tree on page 22 for information about moving between folders. 
 

E-mails (on phone) 
From any mail folder, you can search for a text string contained in an e-mail in the 
DME client. 

 Searching for a text string 

1 Open the menu, and select Search > E-mails (on phone) (or select the  
Desktop icon, and choose E-mails (on phone)). 

2 Complete the search fields in the form: 
1.  Search text: In this field enter the text to search for. This field cannot be 

blank. 
2.  Field: Select the e-mail fields in which to search for the specified text. 

Click to choose between the following options: 
Any field: All text fields are searched for the specified text string. 
Sender, recipient: Only Sender and recipient fields are searched. 
Subject: Only the Subject field is searched. 
Subject, Body: Both the Subject and the Body fields are searched. 
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3.  Folder: Choose the folder in which the e-mails to be searched are located. 
Click the navigation key to choose between the available mail folders. See 
Navigating the folder tree on page 22 for information about moving between 
folders. Only the folder shown in this field is searched (any subfolders are not 
searched). 

3 Select Search. 
The search results are displayed. If no results are found, DME shows a message that 
no matches are found, and you are returned to the search screen after confirming the 
message. 

 
The DME menu has the following options: 
 New search: Return to the search screen with every option in the search screen 

reset to default values. 
 Refine search: Return to the search screen, but retain the selections you already 

made. 
 Previous page: If more results were returned than the specified number of results 

per page, and you are not looking at the first page, you can go to the previous 
pageful of results. Alternatively, move the navigation key to the left. 

 Next page: If more results were returned than the specified number of results per 
page, you can go to the next pageful of results. Alternatively, move the navigation 
key to the right. 

 Actions: This submenu lets you delete all the found e-mails, the selected 
e-mail(s), remove all attachments from the found e-mails, or place a call to the 
sender of the e-mail. 

Press Close (or Back on some devices) to close the search and return to the e-mail 
folder from which you opened the search window. 
 

Calendar 
DME contains a complete, built-in calendar, which you can use to get an overview of 
your appointments, and from which you can create new meetings and invite other 
people to the meetings. Meeting invitations from other people are received in the 
DME Inbox, and transferred to the calendar when accepted. Meetings that you create 
for yourself are saved directly in the Calendar. Meetings with other participants are 
also saved directly in your Calendar, and sent as invitations to the other participants 
(and resources) at the next calendar synchronization. 
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Interaction with native calendar 
The DME calendar may be integrated with the calendar application which is native to 
your device. This depends on a security option in Calendar settings (note: requires 
DME Server 3.5 minimum). 
The security setting is called Calendar mode, and has three options: 
 Open 

In Open mode, meetings, all-day events, and anniversaries created on the 
collaboration system or in the DME Calendar are also shown in the native calendar 
(insofar the native calendar supports the features of the DME Calendar - for 
instance, meeting attachments are not linked to calendar entries in the native 
calendar).  
Personal appointments created and edited from the native calendar application are 
synchronized with your collaboration system. However, you cannot invite other 
people or perform other advanced actions. 
See also Recurring meetings on page 50. 

 Mixed 
In Mixed mode, meetings, all-day events, and anniversaries created on the 
collaboration system or in the DME Calendar are also shown in the native 
calendar. However, any potentially sensitive information is replaced by a message 
from DME. The only data shown are Start, End, and Alarm times. Thus, a meeting 
in the native calendar might look like this: 

Subject: Secured by DME! 
Body: Please log in to the DME calendar to see content. 
Location: Please log in to the DME calendar to see content. 
Start time: 10:00 
End time: 11:00 
Alarm time: 9:45 

Furthermore, Subject, Body, and Location are encrypted by DME when saved to 
the device disk. 
Personal appointments created from the native calendar application will be secured 
after synchronizing with the collaboration system. 

 Secure 
In Secure mode, all calendar entries created on the collaboration system or in the 
DME Calendar are kept in DME. There is no interaction with the native calendar. 
This includes alarms - no alarms will be shown for calendar events in Secure 
mode. If you rely on calendar alarms, but also want high security, choose the 
Mixed mode option. 
Personal appointments created from the native calendar application are not 
synchronized with the collaboration system. 

See also Calendar settings on page 72. 
 

Switching calendar modes 
If you switch the calendar mode, DME will process your calendar entries after you 
synchronize. 
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 Switching from Open/Mixed to Secure mode: 
All entries in the native calendar are merged into the DME calendar, and are then 
removed from the native calendar. Any entries that you subsequently create in the 
native calendar will remain there and will not be synchronized with the 
collaboration system, as there is no longer any interaction with the DME calendar. 

 Switching from Secure to Open/Mixed mode: 
Calendar items within the calendar synchronization window are copied out from 
the DME calendar to the native calendar. 

In Open mode, DME uses both the native calendar database and the DME calendar 
for storing and displaying calendar entries. The fields supported by the native calendar 
are stored there, such as Subject, Body, and Location. The fields not supported by the 
native calendar are stored in DME. This is the most efficient way to store calendar 
entries.  
When you switch from Open/Mixed to Secure mode, all fields are moved from the 
native calendar into the DME calendar, and synchronization with the collaboration 
system only affects the DME calendar. When you switch back to Open/Mixed mode, 
the calendar entries are split up again in the way mentioned above, and are thus visible 
in the native calendar. 
When switching from Open to Mixed mode, the Subject, Body, and Location fields 
are copied to the secure DME calendar, and a message from DME is entered in the 
native calendar instead. Switching from Mixed to Open mode reverses this process. 
 

Calendar views 
To view the calendar entries in the DME calendar, select the  icon from the 
Desktop, or select View > Calendar in the DME menu. 
The calendar opens on today's date in the Day view. Using the DME menu, you can 
choose to see your calendar entries in three different views: 
 Day view: See all calendar entries for one day. Browse to the previous or next day 

using the left or right navigation key (Android: swipe left or right). The title text 
tells you the day in the week and the date of the day you are currently viewing. For 
each calendar entry, the time and subject of the entry are shown. 

 Week view: See all calendar entries for one week. Browse to the previous or next 
week using the left or right navigation key (Android: swipe left or right). The title 
text tells you the number and starting date of the week you are currently viewing. 
For each calendar entry, the week day, time, and subject of the entry are shown. 

 Month view: See all calendar entries for one month. Browse to the previous or next 
month using the left or right navigation key (Android: swipe left or right). The title 
text tells you the name of the month and the year you are currently viewing. For 
each calendar entry, the month name, date, time, and subject of the entry are 
shown. 

To switch between the views, select View day, View week, or View month in the 
DME menu. 
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Go to date 
To show a certain date in the DME calendar, select Go to date in the DME menu. 

 
Enter the desired date. You can use the left and right navigation keys to move between 
the fields in the date, and the up and down keys to spin the numbers within each field - 
or you can tap the down arrow to pop up a small calendar.  
Select OK to go to the selected date. The date will be shown in the Day view. 
To go to today's date, select Go to today in the DME menu. 
 

Calendar actions 
From each view, you can select the following actions in the DME menu (in addition to 
the Go to ... and View ... options): 
 New meeting: Create a new meeting. The default date set for the new meeting is 

the currently viewed day. In the Week view and the Month view, the meeting date is 
set to the first day within the viewed range of days, for instance the first in the 
month currently viewed. If that date has passed, today's date is suggested as the 
meeting date. 

 Synchronize: Perform a manual calendar synchronization. See Synchronization 
overview on page 10 for more information. 

 About DME: See information about your version of the DME client. 
 

Viewing and editing meetings 
To view details about a meeting in the calendar, move to it, and click to open it. You 
can now see all the fields that have been completed for this meeting, but you cannot 
initially change any fields. 
Your options in the DME menu depend on whether you organized the meeting in 
question (you are the chair) or you were invited as a participant. 

 Calendar options for the meeting chair 
If you are the chair of the meeting, the following options are available: 
 Edit: Select this option if you want to change any of the details in the meeting, 

including removing and adding participants. All fields in the meeting invitation are 
now opened, and you can make any change you want. 
Note: The Domino collaboration system permits the use of formatted text and the 
embedding of attachments in the meeting description. If the meeting description 
contains attachments, you will not be able to edit the description on the device. If 
there are no attachments, and you edit the Description field on the device, any 
formatting and any embedded objects in the field will be lost when the calendar 
event is synchronized back to the collaboration system. 
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Select Attachments in the DME menu to add or remove attachments in the 
meeting. See Sending attachments. 
When you are done editing the meeting, you may select Check free time in the 
DME menu to verify that all participants are free at the time in question, if you 
have changed the meeting time or date. For more information, see Checking free 
time on page 53. Select Save in the DME menu to save your changes. You are 
prompted to enter a comment about the reason for changing the meeting, which is 
sent to each participant when you synchronize. If you remove a participant from 
the list of required participants, the participant receives a meeting cancelation 
notice, and the meeting will be removed from the calendar of that participant. 

 Reschedule: This option is available if you are the chair, and you have invited 
other people to the meeting. Select this option if you want to move the meeting to 
another date or time. A new screen opens, letting you set a new date and time for 
the meeting. 

 
Change the date and time. You may now select Check free time in the DME 
menu to verify that all participants are free at the time in question. For more 
information, see Checking free time on page 53. 
Select Save or Send and save in the DME menu to save your changes. You are 
prompted to enter a comment about the reason for rescheduling the meeting, which 
is sent to each participant when you synchronize. 

 Cancel meeting: This option is available if you are the chair, and you have invited 
other people to the meeting. Select this option if you want to cancel and delete the 
meeting. The meeting will be removed from the calendar of all participants. You 
are prompted to enter a comment about the reason for canceling the meeting, 
which is sent to each participant when you synchronize. 
Note: If your collaboration system is Exchange 2003, DME is unable to process 
meeting cancelation notices. This means that if you receive a notice about a 
canceled meeting, you must accept the cancelation in Outlook or Outlook Web 
Access (the OWA webmail). 

 Delete: This option is available if you are the chair, and you have not invited other 
people to the meeting (it is a personal appointment or similar). Select this option if 
you want to cancel and delete the appointment. The appointment will be removed 
from your calendar in DME immediately, and from your collaboration system 
when you synchronize. 

When you save any changes, DME asks you if you want to synchronize the calendar 
immediately. 
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 Calendar options for meeting participants 
If you are a participant in the meeting, and not the chair, the following options are 
available: 

 
 Edit: Select this option if you want to change details in the meeting. As a 

participant, you only have access to toggle the Private status of the meeting and the 
Alarm (and possibly set the alarm time). After editing these fields, select Save in 
the DME menu to save your changes. 

 Decline 
 Propose new time 
 Delegate: For information about these three options, see Responding to meeting 

invitations on page 48. Note that selecting Decline or Delegate removes the 
calendar entry from the calendar immediately. 

After making any changes, DME asks you if you want to synchronize the calendar 
immediately. 
 

Responding to meeting invitations 
When meetings are booked on the collaboration system, all invited participants receive 
a meeting invitation by e-mail, containing information about the meeting. 
In the DME client, a meeting invitation is recognized by a clock/e-mail icon in the 
Inbox. See E-mail icons on page 25 for more information. 

 Responding to a meeting invitation 
1 Open the meeting invitation. Browse through the pages of the invitation to see the 

subject and time of the meeting, who organized the meeting, who have been 
invited (participants), and any information about location and resources involved 
in the meeting. 

2 In the DME menu, you can now choose among a number of options. Most of the 
options are available on all supported collaboration systems, but there may be 
differences, which are noted below.  
Furthermore, the description of the actions pertain to the standard way of inviting 
to meetings. For instance, in Domino the chair can select options in the meeting 
invitation in Notes specifying that he or she does not want to receive responses 
from invitees (participants), wants to prevent counter-proposals, or wants to 
prevent delegation. Such options are naturally observed by DME, even if they are 
not mentioned in the descriptions below. 
The following options may be available: 
 Accept: Accept the meeting invitation. The meeting is created in the calendar, 

and a notification of your acceptance is sent to the meeting organizer/chair. 
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 Decline: Decline the meeting invitation. Notification of this is sent to the 
organizer/chair and any other participants. 

 Tentatively accept: If you want to attend the meeting, but you are not sure 
that you are available at the proposed time, you can tentatively accept the 
meeting. This way the meeting is booked in your calendar, but the time still 
appears free for other users. Note: On Exchange 2003 systems, this action is 
not available for recurring meetings. 

 Propose new time: If you would like to attend, but you are not available at the 
proposed time, you can propose a new time (also called countering the meeting 
proposal). Selecting this option opens a new screen in which you can select a 
new time, date, and time zone for the meeting. 

 
When you are done, you can open the DME menu and select Send to send the 
new proposed time, or Check free time to see if the new proposal conflicts 
with the calendars of any of the required participants. For more information, 
see Checking free time on page 53. When you send the new proposed time, 
the meeting chair/organizer will receive an e-mail with the subject Countered: 
and the subject of the meeting. 
Please note that once the calendar entry has been accepted, you are not able to 
change the time zone of the calendar entry if you subsequently edit the 
calendar entry from your calendar to propose a new time. Note: On Exchange 
2003 systems, this action is not available for recurring meetings. 

 Delegate: If you are unable to attend the meeting, you may want to send 
someone else in your stead. Choose Delegate, and select another user from 
your local or global address book. The Delegate field functions as other 
recipient fields, with type-ahead selection of recipients and the ability to 
choose from the local and global address books. See Entering recipients on 
page 32 for more information. 

 Show calendar: Open your DME calendar on the day of the meeting so you 
can check your schedule for that day. Select Back to return to the meeting 
invitation. 

 Delete: Delete the current meeting invitation without performing any action 
with it. To get the meeting invitation back into your mailbox, you must 
synchronize your e-mail (unless the option Delete only locally is set to No in 
E-mail settings (see E-mail settings), in which case the invitation will be 
deleted on the server also at the next synchronization). Note: On Exchange 
2003 systems, this action is not available for recurring meetings. 
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3 When you accept, decline, tentatively accept, propose a new time, or delegate a 
meeting invitation, you are given the option to add a comment. If you enter a 
comment, it is sent to the organizer/chair. Select Continue / Send to complete the 
action, or Cancel / Close to return to the meeting invitation. Note: On Exchange 
2003 systems, not all actions allow you to reply with comments. 

4 When you respond to a meeting invitation by using any of the above actions, the 
e-mail containing the invitation is removed from your Inbox, and if you accepted 
the meeting, your calendar is updated on the collaboration system at the next 
calendar synchronization. 

 

Recurring meetings 
Recurring meetings created on the collaboration system are synchronized to DME as a 
series of individual appointments. This means that if you edit one in a series of 
meetings, only that instance of the meeting series will be changed. If you want to edit 
the entire series, you must do so in Microsoft Outlook or Lotus Notes. 
Recurring meetings created on the device are sent to the server as a true series or 
recurring meetings, not as individual events. If you create a recurring meeting on the 
device without an end date, the DME server will add an end date automatically. The 
end date will be five years in the future. 
 

Booking meetings 
You can book meetings in your corporate calendar from the DME client. You can 
invite people to attend the meeting, and you can reserve rooms and resources. This 
basically works the same way as booking meetings in your collaboration system. 

 Creating a new meeting 
1 There are several ways to start the creation of a new meeting: 
 From the Desktop or a mailbox: Select Create > Meeting in the DME menu. 
 From the Calendar: Select Create meeting in the DME menu, or tap the Add 

(plus) icon (not all platforms). 

 From the Desktop, select the New meeting icon . 
 Or press the shortcut you have defined for New meeting from anywhere in 

DME (not all platforms). 
2 Enter meeting details: see Entering meeting details on page 51. 
3 Add participants: see Adding participants on page 52. 
4 Enter a location and book resources: see Location and resources. 
5 Check to see if the calendars of all participants are free at the proposed time: see 

Checking free time on page 53. 
6 Add attachments: see Sending attachments. 
7 From the DME menu, select Save and send (if participants or resources have been 

invited), or Save (if the meeting is for yourself only). 
The meeting is created in your calendar, and meeting invitations are sent to the 
selected participants and resources at the next calendar synchronization. 
Note that you can create a new meeting invitation by selecting recipients first from a 
search and then creating the meeting invitations. For more information, see Global 
Address Book on page 39. 
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During the creation of a meeting, you can also choose Save as draft in the DME 
menu or Close. Selecting Save as draft saves the meeting as a draft, allowing you to 
interrupt your work on the meeting proposal for a later time. The Close option closes 
the current meeting draft, and prompts you if you want to save it as a draft before 
closing it.  
The meeting is shown in your calendar as a regular meeting, but with a blue, hollow 
triangle on top of it, and it will not be synchronized to the collaboration system. Please 
note that draft meetings are not synchronized with the server. This means that if you 
import your calendar from the server, any draft meetings in your DME calendar on the 
device will be lost. 
 

Entering meeting details 

 
The Meeting details tab contains the following fields: 
  Subject: Enter a subject for the meeting. 
 All day: Mark the meeting as an all-day meeting. When you select this field, you 

cannot enter start and times for the meeting. The meaning of "all-day" depends on 
which collaboration system you are using: 
Lotus Domino: All-day events in Domino do not support the use of other 
participants, rooms, or resources. An all-day event created in Domino will only 
display a Details tab and a Location tab when it is synchronized to the client - it is 
not possible to add participants and resources to the event. 
When you create an all-day event on the client, you are able to add participants 
etc. to the event. However, when the event is synchronized to the server, it is 
created in Domino as a regular meeting, and the client will reflect this also (even 
though the All day field is still checked). 
MS Exchange: In Exchange, you are able to invite participants and book resources 
for all-day events - the All day field simply signifies that the event has no time 
constraints. 

 Symbian users should be aware that all-day events created in the native 
device (as "Memos") will appear as all-day events in the DME calendar, but the 
meeting type cannot be changed in DME. 
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  Date and time: Enter starting and ending dates and times for the meeting. 
  Time zone: Enter the time zone for the starting and ending times. See Time 

zones. 
  Alarm: Enable or disable the alarm. When the alarm is enabled, you can enter 

a date and time for when the alarm should go off. 
  Private: Mark the meeting as private. This means the the meeting details are 

not visible to other people in the collaboration system when you sync the calendar 
item, but your time will appear booked. 

 Description: Enter a description of the meeting, agenda, etc. 
 

Adding participants 

 
In the Participants tab, you can add meeting participants from Local contacts on the 
device and from the global address book on the server. You can enter Required 
participants ( ), Optional participants ( ), and FYI participants ( ). 

 Entering meeting participants 
1 Click one of the Participants fields. The field functions as other recipient fields, 

with type-ahead selection of recipients and the ability to choose from the local and 
global address books. See Entering recipients on page 32 for more information. 

See Global Address Book on page 39 for information about selecting participants 
before creating the meeting. Participants selected from a Global Address Book search 
result are added to the required participants field ( ). 
 

Location and resources 

 
In the Location and resources tab, you can enter a location for the meeting, and book 
rooms and resources that are available in the collaboration system. 
In the form, you can enter information into the following fields: 
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  Location: Here you can enter free text describing the location of the meeting - 
for instance an office, a country or a city. 

  Rooms: Here you can select one or more of the rooms available in the 
collaboration system. See below. 

  Resources: Here you can book one or more of the resources available in the 
collaboration system. See below. 

Before selecting rooms or resources, you must download the available rooms and 
resources from the collaboration system to your device. 

 Downloading rooms and resources 
The first time you click either of the Rooms or Resources fields, DME will ask 
you if you want to download rooms and resources now. You must do this in order 
to be able to select rooms and resources. Subsequently, you can refresh the list of 
resources by selecting Get resources in the DME menu, and then select Yes to 
download rooms and resources from the collaboration server. 

 Selecting rooms and resources 
1 Move the cursor to the Rooms or Resources field. 
2 Open the drop-down list by tapping the icon or clicking the navigation key. 
3 You may have to select which site you want to select your rooms and resources 

from by clicking. Rooms and resources are grouped under sites; tap the + to 
expand a site (or use the right navigation key). If your organization only uses one 
site, the list of rooms or resources is shown directly. 

4 Scroll up and down in the list of rooms or resources, and mark the rooms or 
resources you want to add. Note that if the people capacity of the room is entered 
in the collaboration system, it is shown in the list. 

 
5 Select OK. 

The selected rooms or resources are entered into the field in question. 
 

Checking free time 
When participants, rooms and resources have been added, you can check if they are 
available within the specified time frame. This can be done from any of the tabs. 
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 Checking free time 
1 Open the DME menu, and select Check free time. 

After DME has checked on the server, you will see a message indicating whether 
all participants and resources are available or unavailable within the selected time 
frame. 

 
2 Select Yes to show alternative time frames 

or 
Select No to keep the current time frame. 
If you select Yes to show alternatives, you will see a list of time frames within 
which all participants and resources are available. 

 
3 Scroll up or down to select a new time frame. 
4 Select OK to use the selected time frame or 

Tap the time frame you want to use (Android) 
The meeting details are changed to reflect the update. 
 

Contacts 
DME contains an internal address book for your contacts - the DME Address Book. 
The DME Address Book reflects your personal address book on the collaboration 
system. The two address books are kept synchronized with each other, if the setting 
Contacts sync. is enabled (see Contacts sync. settings on page 74). 
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By default, your DME contacts are synchronized with the contacts in the native 
Contacts application. This way, all your contacts - both business and personal - can be 
maintained in either DME or in the Contacts application. If you manage your contacts 
in this way, it is important that you do not use any other software (iTunes, Mobile Me, 
Microsoft ActiveSync, Nokia PC Suite/Ovi Suite, or similar depending on platform) 
for the same purpose, as this may cause duplicate entries or corruption in your address 
book over time. 
However, you can choose to keep your business contacts in the DME Address Book 
and your private contacts in Contacts - for reasons of security, work/life balance, or 
both. For more information, see Contacts sync. settings on page 74. 
Whenever you create an e-mail or book a meeting, you can choose recipients from the 
Global Address Book (your company directory) or from your local contacts. See 
Address book integration see "Entering recipients" on page 32, on page 33 for more 
information. 

 See Initial import and reset on page 12 for information about special 
considerations in connection with the initial synchronization or import of contacts 
from the collaboration system. 
 

The DME Address Book 
To view your contacts, select the  icon from the Desktop, or select View > 
Contacts in the DME menu. 
Your list of contacts is displayed. The DME Address Book contains the contacts from 
your collaboration system's Personal Address Book. If you make a change in your 
contacts either in DME or in Outlook/Lotus Notes, your changes are kept 
synchronized. 
The DME Address Book may or may not be kept in sync with the local Contacts 
application on the device. You can choose to keep the two completely separate in 
order to keep personal and business contacts apart, and to keep your business contacts 
secure. For more information, see Contacts sync. settings on page 74. 
You can browse the list contacts, or you can start typing a name to quickly move to a 
certain contact. You can select one or more contacts. 
The following options are available in the DME menu: 
 Call: To call the selected contact, select Actions > Call. If multiple phone 

numbers are associated with the contact, DME will ask which of the numbers you 
want to call. 
An note about international calls: If a phone number is preceded by + or 00, DME 
will remove any initial 0 in the first set of parentheses from the number before 
dialling it. Otherwise, it will be dialed as it is. For instance: The number 
(012)-555-23421 will be sent to the phone dialer as is. The number 
+44(012)-555-23421 will be sent to the dialer as +44(12)-555-23421. This is in 
compliance with international standards. 

 Create: Select Create > E-mail / Meeting to create an e-mail to or a meeting 
with the selected contact(s). Only contacts with associated e-mail addresses are 
included in the recipient or participant list. 
Or select Create > Contact to create a new contact. See below for more 
information. 
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 Synchronize: Select this option to synchronize your local contacts with your 
collaboration system personal address book immediately. 

 Actions: In this menu, you can choose the following options: 
 Call: See above. 
 Send SMS: Send a text message to the selected contact(s). 
 Edit contact: Edit the currently highlighted contact. See below for more 

information. 
 Delete: Delete the currently selected contact(s). 

 Details: View all contact information for the currently highlighted contact. 
 

Interaction with the device Contacts 
As mentioned previously, the DME Contacts may be integrated with the contacts 
application which is native to your device. This depends on a security option in 
Contacts settings (note: requires DME Server 3.5 minimum). 
The security setting is found in the Device Address Book section, and has three 
options: 
 Copy all fields (a.k.a. Open mode) 

In Open mode, contacts created on the collaboration system or in the DME 
Contacts are also shown in the native contacts.  
Contacts created and edited from the native contacts application are synchronized 
with your collaboration system. 
The contacts are placed in a separate DME group (see Adding and editing 
contacts). Contacts synchronized with 3rd party services, such as Google or 
Facebook, will not affect this group. However, please note that if you aggregate 
contacts (linking contact info for the same people in different contact groups), this 
aggregation will be lost if you should re-import your contacts from the 
collaboration system. 

 Copy name and phone numbers (a.k.a Mixed mode) 
In Mixed mode, contacts created on the collaboration system or in the DME 
Contacts are also shown in the native contacts. However, any potentially sensitive 
information is replaced by a message from DME. The only data shown in the 
native contacts app are the name and phone number. Any other data are hidden, 
and the fields are empty in the native contacts app. 
Personal contacts created from the native contacts application will be secured after 
synchronizing with the collaboration system. 

 Don't use (a.k.a. Secure mode) 
In Secure mode, all contacts created on the collaboration system or in the DME 
Contacts are kept in DME. There is no interaction with the native contacts. 
Personal contacts created from the native contacts application are not 
synchronized with the collaboration system. 

See also Contacts sync. settings on page 74. 
 

Switching contact modes 
If you switch the contacts mode, DME will process your contacts the next time you 
synchronize. 



 57 
 

  User guide: Windows Mobile devices : Contacts  

 Switching from Open/Mixed to Secure mode: 
All native contacts are merged into the DME Contacts, and are then removed from 
the native contacts. Any contacts that you subsequently create in the native 
contacts will remain there and will not be synchronized with the collaboration 
system, as there is no longer any interaction with the DME Contacts. 
To merge the contacts, DME sends all your native contacts to the server. The 
server then checks against the collaboration system to weed out any duplicates 
(contacts that exist both locally on your device and in your personal address book 
on the server). All non-duplicates are added to your personal address book on the 
server. If DME cannot reliably determine whether a contact is a duplicate or not, it 
is added with a number after the name. Your contacts are then imported into the 
DME Contacts, and the process is complete. 

 Switching from Secure to Open/Mixed mode: 
Your contacts are copied out from the DME Contacts to the native contacts. This 
corresponds to an initial import. If the server setting Action to perform on client 
upon initial import is set to Wipe, all contacts are removed first. If it is set to 
Merge, the contacts are added to the local contacts, and all the contacts are then 
sent to the server for duplicate control. See Initial import and reset on page 12. 

 

Adding and editing contacts 
Different contact applications on different phones and phone platforms support 
different contact fields. A contact field is for instance the First name field or the 
Telephone field in a contact. When synchronizing the address book in MS Outlook or 
Lotus Notes to a mobile device, different third-party applications may map the fields 
in Outlook/Lotus Notes to the phone in different ways. 
The DME Address Book supports a large, but fixed number of fields. By using DME 
for synchronizing contacts, you can be certain that everybody in the organization maps 
contacts from the collaboration system to their device in the same way. 
When you select Create to create a new contact in the DME Address Book, DME lets 
you add a contact with a fixed number of fields: 
First name 
Last name 
Mobile 
Telephone 
E-mail 
Company 
Department 
Job title 
To add more fields, select Add detail in the DME menu, scroll to the desired field, 
and select OK. 
In the same way, if you select Actions > Edit contact to edit an existing contact, 
DME shows at least the fields mentioned above, and any other fields that have already 
been completed. To add more fields, select Add detail. 
In total, DME supports the following fields: 
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Account name 
Anniversary 
Assistant 
Assistant phone 
Birthday 
Carphone 
Categories 
Children 
City 
City (business) 
City (home) 
Company 
Company phone 
Country/Region 
Ctry./Reg. (bus.) 
Ctry./Reg. (home) 
Customer ID 
DTMF 
Department 
E-mail 
E-mail (business) 
E-mail (home) 
Extension 
Extension (bus.) 
Extension (home) 
Fax 

Fax (business) 
Fax (home) 
File as 
First name 
Government ID 
IM ID 
IM ID 2 
IM ID 3 
Internet tel. (bus.) 
Internet tel. (home) 
Internet telephone 
Job title 
Last name 
Location 
Manager 
Middle name 
Mobile 
Mobile (business) 
Mobile (home) 
Nickname 
Note 
P.O. Box 
P.O. Box (bus.) 
P.O. Box (home) 
Pager 
Postal/ZIP code 

Postal/Zip (bus.) 
Postal/Zip (home) 
Push to talk 
Radio phone 
SIP 
Share view 
Spouse 
St./Prov. (bus.) 
St./Prov. (home) 
State/Province 
Street 
Street (business) 
Street (home) 
Suffix 
Tel. (business) 
Tel. (home) 
Tel.2 (business) 
Tel.2 (home) 
Telephone 
Title 
Video call 
Video call (bus.) 
Video call (home) 
Web addr. (bus.) 
Web addr. (home) 
Web address 

When you add, edit, or delete contacts on the device, the changes are synchronized to 
the collaboration system at the next scheduled or manual sync, or when the DME 
server initiates a contact synchronization. 
 

Work/home scheme 
Some of the fields in the DME Address Book mentioned above are special in that they 
function as a sort of alias for up to three distinct fields. An example of this is the field 
Mobile. When you enter a number into the Mobile field and synchronize, then how 
can DME know if the number should be placed in the Cell phone, Mobile, or Mobile 
2 in Lotus Notes, or in Business Mobile, Home Mobile, or Other Mobile in MS 
Outlook? 
There is no issue if you enter values in the specific mobile number fields: Mobile 
(home) and Mobile (business). These fields are directly supported by the 
collaboration system. The issue only exists if you use the generic Mobile field. 
When this field (Mobile) is updated on the device, and you choose to synchronize 
contacts, DME considers the following work/home scheme. Note that each row in the 
table below lists all completed fields related to mobile phone numbers: 

This field in the DME 
Address Book 

 
maps to 

this field in Notes or 
Outlook 

Mobile ->  Work mobile 

Mobile 
Mobile (business) 

-> Home mobile 
Work mobile 
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Mobile 
Mobile (home) 

-> Work mobile 
Home mobile 

Mobile 
Mobile (business) 
Mobile (home) 

-> Other mobile 
Work mobile 
Home mobile 

Note: If you are using Lotus Notes, the last row in the table only applies if you are 
running Domino 8 and above. If you are running Domino 7, the value in the Mobile 
field is stored in a hidden field in DME, as Domino 7 and below only supports two 
mobile numbers. 
DME not only employs the work/home scheme to make a qualified guess about where 
to place the mobile phone number, but from all of the following fields, which are of 
the same type as Mobile: 
E-mail 
Fax 
Mobile 
Tel./Telephone 
Address 
 

To dos 
A to-do item is a special type of calendar item and is synchronized with your 
collaboration system by DME.  
To-do items are created as tasks in the Windows Mobile Tasks application. They are 
synchronized with your collaboration system by DME. See Initial import and reset on 
page 12 for information about special considerations in connection with initial 
synchronization or import of to dos from the collaboration system. 
For a to-do to be included in the synchronization from the collaboration system to the 
device, the following criteria must be fulfilled by the to-do on the collaboration 
system: 
1 A due date has not been specified, and it has not been marked as complete 

(Domino only). 
2 Or the to-do is overdue and not marked as complete, regardless of the values in the 

starting date and due date fields. 
3 Regardless of the above, a to-do is included if either the starting date or the due 

date is within the time span set in To-do settings on page 74 (the sync window). 
Examples: 
The sync window is set to 10 days in To-do settings, and today is April 15th.  
1 A to-do on the collaboration system was created on March 23rd with a due date on 

April 17th. This to-do is synchronized to the device because the due date is within 
the 10-day sync window specified in the To-do settings. 

2 Another to-do was created on March 3rd, with a due date of March 16th. It has not 
been marked as completed. This to-do is synchronized to the device. When it is 
marked as completed, it will no longer appear on the device. 
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Notes 
 

If your collaboration system is Lotus Domino, you can synchronize notes (formerly 
called "journals") with your DME client. 
This requires that Notes synchronization is enabled in Settings (see Notes sync. 
settings on page 75). 

Select  on the Desktop to open the Notes screen. In the initial screen, you can see 
the note categories that have been synchronized from Lotus Notes to the device. Tap a 
note category to view the notes within that category. In this view, you can use options 
in the DME menu to sort the notes by Subject or by Entry Date. 

 
Select Synchronize in the DME menu to synchronize your notes manually. Click a 
note to edit it, or select New note in the DME menu to create a new note. 

 
When you create or edit a note, the Note screen shows fields where you can enter or 
edit the Subject, Description, Category (or categories), and Date of the note. 
Furthermore, you can add or review any attachments for the note. For information 
about working with attachments, see Attachments and Sending attachments. 
 

Feeds 
With a DME 3.6 server, you can get RSS feeds on your client. The feeds are defined 
by the DME administrator. 



 61 
 

  User guide: Windows Mobile devices : Feeds  

An RSS feed is a stream of links to articles or other content from a website that is 
frequently updated, such as a news site. Another source of an RSS feed could be a 
sales tools database (a list of new orders or other information from the sales database) 
or many other things. The source of a feed is called a feed provider. 
The advantage of using DME's RSS feed reader over any other feed reader is that the 
content of the feeds, which may be sensitive if the feed source is an internal database, 
is kept within the secure storage space of DME. 

To view the feeds that have been set up for you, select  on the Desktop. A screen 
such as the following is shown: 

 
Each feed to which you subscribe is listed. The number below each feed shows the 
total number and the number of unread articles in the feed. You or the administrator 
can limit the number of articles available on the device at any one time (see Feed 
sync. settings on page 75). A standard feed called Welcome to DME RSS Feeds is 
usually included in the list; this feed tells you more about the DME RSS Feeds 
functionality. 
If you highlight a feed and select Details in the DME menu, you can see more 
information about each feed (if supported by the feed provider). 
The feeds are updated at regular intervals. The server takes care of sending a 
notification to DME when this happens. To update the feeds manually, select 
Synchronize in the DME menu. 
To view the articles of a feed, click the feed title: 

 
Unread articles are preceded with a star icon. In the DME menu, you can choose to 
mark the selected article or articles or all articles as read or unread. 
Click to read an article: 
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Most articles are just an excerpt of a larger article, and include a link to the full article. 
To view the full article in a browser, select Open in the DME menu. 
 

Cost control 
The DME administrator is able to control phone costs by restricting the phone 
numbers a user is able to call. This is called the DME Cost Control. 
On the DME server, the DME administrator can set up rules that control your use of 
the phone in four areas: ordinary phone calls, SMS (texting), MMS, and data traffic. 
These rules can be set up differently, depending on whether the phone is currently 
roaming (you are traveling and therefore using a different phone network). The prices 
assigned to each call, SMS, etc. are set up on the server as a subscription. Each device 
uses one subscription. 
The rules set up by the administrator are tied to the phone's SIM card, not the phone as 
such. 
The control system set up by DME administrator works in two ways: through a list of 
allowed phone numbers (the inclusion list) or restricted phone numbers (the exclusion 
list), and through a credit balance. 
 

Inclusion and exclusion lists 
In the inclusion list, the DME administrator defines a set of numbers that you may call 
at all times. This could be the number for your company office, your manager, etc. 
In the exclusion list, the DME administrator defines a set of numbers that must never 
be called. This could be numbers with foreign country codes, premium service 
numbers, or similar. 
If you dial a number, which is included in the exclusion list (and not in the inclusion 
list), DME will show a warning that you are attempting to dial a restricted number. 
 
Depending on how the DME administrator has set up the Call Manager, you may be 
permitted to dial the number anyway (if your balance permits - see next section). If 
you do, you should know that the call will be registered by DME, and the 
administrator will be able to see who you called. If you are not permitted to make the 
call, your call will be blocked. 
Note that the above applies to phone calls, SMS/texting, and MMS. In you are sending 
an SMS or an MMS to multiple phone numbers, each of the numbers will be treated 
according to the rules above. 
 

Call balance 
For each user or group of users, the DME administrator defines a maximum limit, or a 
quota, for each type of traffic: phone calls, SMS/text, MMS, and data. A price is 
assigned to each unit of the type of traffic - one minute of talk, one text, one MMS, 
and one KB of data. Another price is assigned to the same type of traffic when you are 
roaming. 
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As you use your phone, DME keeps track of the number of units you use. If the total 
price of the units consumed exceeds the limit defined for you, DME will either show a 
warning with your current balance before placing the call, or DME will show the 
warning and then block the call (depending on how the DME administrator has set up 
DME Cost control). 
 
The warning is shown every time you increase the balance by texting or placing a call.  
In case of data traffic, DME will not block the data connection, only issue a warning if 
your quota is exceeded. This is because the DME client relies on the data connection 
being open. 
Your balance is reset once or twice a month (depending on how the administrator has 
set up your subscription). 

To view your current balance, click the  icon on the Desktop, or select Tools > 
Cost control in the DME menu. The window shows the limit that has been defined for 
you, your current consumption, and the balance left for you to use. 
 
If you have exceeded your quota, the balance is shown on a red background. The 
original quota is shown after the balance (in parentheses). 
The balance is also shown in any warnings that you receive about restricted numbers. 
 

Files 
If file synchronization is enabled, files can be synchronized using scheduled sync or 
manual sync. Files can be synchronized in one of three ways, which is determined by 
the sync method selected in the file rule set up by the DME administrator: 
 One-way, just like receiving an e-mail: The files are downloaded to your device if 

updated on the server since your last sync. 
 Execute: The files are downloaded and executed on your device, if they were 

updated on the server since your last sync. 
 Two-way, just like editing a meeting invitation: The files are downloaded to your 

device if updated on the server since your last sync, or uploaded to the server if 
you updated the files on the client since your last sync. 

For a file to be of use on the device, the file type in question must have an associated 
viewer. Not all devices are for instance able to view Word documents. For more 
information, consult your DME administrator. 
 

Tools 
The Tools menu in the DME menu contains options that apply to the DME client in 
general. The menu contains the following items: 
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 Settings: Control the look and feel and the operation of your DME client. See 
Settings on page 66. 

 Reset: Refresh the contents of your DME client with a new copy from the server. 
Care should be taken before resetting. See Initial import and reset on page 12. 

 Out of office: Lets you enable, disable, or change your out of office message. See 
Out of office on page 65. 

 Change password: With this function, you can change your network password. 
See Changing mailbox passwords on page 8. 

 Set PIN code: With this function, you can temporarily replace your collaboration 
system password by a simpler PIN code for use on the DME client. See Setting 
PIN code on page 64 below. 

 Cost control: Displays your current cost control status. See Cost control on page 
62. 

 Log: Displays the event log, which is kept by the DME client. The log can be 
useful in support questions. See also If you need further assistance on page 81. 

 

Setting PIN code 
For reasons of security, you may be required to enter a long, complex password with a 
mix of letters and special symbols to gain access to the network and collaboration 
system. This may be easy enough to enter on a full PC keyboard, but you might find it 
difficult to enter using your phone keypad. 
Instead of using your collaboration system password for logging in, it is possible to 
substitute the password for a PIN code. A PIN code is another passcode of your 
choice. You are free to define a PIN code that is easier to enter using the keypad than 
the collaboration system password. 
The DME administrator can set a minimum length for the PIN code (4 to 10 letters 
and numbers). In order to maintain high security on the device, the following special 
conditions apply when using the PIN code instead of the regular password: 
 The code defined by you may expire after some time. The validity period of the 

code is set by the DME administrator, and could for instance be 8 hours, 
corresponding to one working day. The validity period begins when you log in to 
DME using your regular password. After this, you can use your code to log in to 
DME, until the validity period runs out. Then you have to use your regular 
password again in order to reset the validity period. You do not have to change the 
PIN code. 
The administrator may choose to allow a PIN code that never expires, but this is 
not recommended. 

 If you attempt to log in using your own code, but you enter the code wrong, then 
you have to use your regular password for your next attempt. Your own code is 
not invalidated, however - you can use it the next time you log in to DME. 

Note that the feature may be disabled by the DME administrator for security reasons. 

 Substituting password for PIN code 
1 Log in to the DME client using your regular collaboration system password. 
2 Select Tools > Set PIN code in the DME menu. 

If you cannot find this option, it is because the DME administrator has disabled it. 
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3 A screen with three fields is shown: 

 
Enter your regular password in the top field Password, a PIN code of your own 
choice in the middle field New PIN code, and repeat your PIN code in the bottom 
field Confirm new PIN code to make sure you entered it correctly. 
The DME administrator has set a minimum length of the PIN code (between 4 and 
10 letters and numbers). 

4 Press OK to complete the PIN code definition. 
Now, when you want to log in, you have a choice of entering your regular password or 
your PIN code in the Login screen, where the Password field is now called 
Password/PIN code. 

 
The name of the password entry field in the Login screen will change back to 
Password when your PIN code expires. 
To reset your PIN code, enter your password in the Set PIN code screen, but leave the 
PIN code field blank. Selecting OK will then show a message that the PIN code has 
been disabled. 
 

Out of office 
With DME, you can create, edit, enable, and disable your Out-of-Office (OOF: 
Out-of-Office Functionality) message. When you synchronize, the information added 
here will update the Lotus Notes agent or Microsoft Outlook rule in the collaboration 
system. This way, you can for instance enable your OOF agent from your phone, if 
you forgot to do so during the last hectic hours at the office before your vacation. 
To configure your OOF rule, select Tools > Out of office. DME connects to the server 
to read the current OOF settings from the collaboration system. 
 
 Enabled 

Select this field to enable the Out-of-Office agent/rule; deselect the field to disable 
the agent/rule. 
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 Start 
In this field you can choose a date and time at which the OOF agent/rule should 
become active, if enabled. 

 End 
In this field you can choose a date and time at which the OOF agent/rule should 
become inactive again. 

 Description 
In this field you can enter or edit the text which will be used in the automatic 
response to people who write to you while the OOF agent/rule is enabled. 

When you are done, select Change or Update (depending on device) to synchronize 
the agent or rule with the collaboration system. There are a few things you should be 
aware of in the way the OOF agent is handled by Lotus Notes and MS Outlook: 

 
Lotus Notes: DME does not support the Lotus Notes system of alternate notifications. 
The text from the Description field will be used as both main and alternate 
notification. 

 
Exchange 2003: Exchange 2003 does not support start and end days for OOF rules, 
and the dates will be ignored by Exchange 2003. 
Exchange 2007/2010: DME does not support different reply messages for internal and 
external recipients. The text from the Description field will be used for both types of 
recipients. 
 

Settings 
When a new device is created in DME, a set of default settings for the device is sent to 
the client the first time the device connects with the server, or when a new user takes 
over an existing device. These settings should represent your company's security 
policy.  
Note that the DME administrator may have blocked your access to changing any or all 
of the settings described in the following sections. When a "permitted range" is 
mentioned in the following sections, the range may in fact have been changed by the 
DME administrator. 
The "Deployment guide" contains information for DME administrators about 
recommended settings and permitted range values. 
 

General settings 
 Launch on startup 

Select Yes/Enabled to make the DME client launch every time you start your 
device. This is default and highly recommended for security purposes. 
Select No/Disabled if you want to start the DME client manually. 

 Language 
In this field you can specify which language to use for the DME interface. The 
language is not necessarily the same as the language selected on the device. 
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 Phone number 
The phone number of the device. The DME server needs to know your phone 
number for sending SMS messages and pushing downloads etc. to the device. 

 Disconnect after synchronization 
If you select this option, DME sill shut down the GPRS connection after 
synchronizing. This is the default value, and is recommended to save connection 
costs. 
If you do not select this option, the GPRS connection is never shut down. 

 Allow sync when roaming 
If this field is set to Disabled, you will not be able to perform manual 
synchronization when using a roaming network. When roaming, you will see a 
message saying that synchronization is not allowed when roaming if you try to 
perform a manual synchronization. 
The device uses information from the SIM card when checking if it is currently 
roaming. As soon as the phone is no longer roaming, you are able to synchronize 
manually again. Performing a manual sync will also inform the server that the 
device is no longer roaming, which is necessary for re-enabling background sync. 
See also Bgr. sync when roaming. 
This setting is for your information only - it cannot be changed from the device. 

 Bgr. sync when roaming 
If this field is set to Disabled, the device will not perform background 
synchronization when using a roaming network. Background synchronization 
covers scheduled synchronization, e-mail and PIM pull, and SMS push 
notification. If Allow sync when roaming is enabled, you will still be able to 
synchronize manually. 
The roaming status of the device is stored on the server. The first background sync 
performed while roaming will therefore be carried out normally, but will also 
inform the server that the device is roaming, effectively cutting the device off from 
further background synchronization. This means that the server is unable to detect 
that the device is back in the home network, unless you perform a manual sync. 
When using this cost-saving feature, it is important to that you perform a manual 
sync when you return to your home network. 
This setting is for your information only - it cannot be changed from the device. 

 NW push when roaming 
As a cost-saving feature, the administrator can disable the network (IP) connection 
when the device is roaming by setting this option to Disabled. If the server setting 
Notify when roaming is enabled, the server will resort to SMS push (if permitted 
by the notification schedule that applies to the device). If Notify when roaming is 
disabled also, the device will receive no notification at all. 
To update the roaming status, you should perform a manual synchronization when 
you return to your home network. 
This setting is for your information only - it cannot be changed from the device. 

 Server path 
This is the path to the DME server. The value is set automatically when installing 
the DME client. The server path should rarely be changed, and only if your DME 
Administrator tells you to. 
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 Network push 
If this function is enabled, the device is set up to receive network (IP) push. This 
means that notifications are received over the GPRS network instead of by SMS. 
The result is faster and usually cheaper notification. This requires that the DME 
server is set up correctly. If the GPRS network is for some reason unavailable, the 
DME server will detect this and send notifications by SMS instead. This system of 
falling back to SMS is called AdaptivePush™. Whenever network push is enabled 
and working on your device, a flash icon  is displayed next to the DME logo at 
the top of your DME client. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming. 
 Network push path 

If network (IP) push is enabled, you must supply a path to the server providing 
the network push connection. This path is usually pushed to your device by the 
DME server. Please contact your DME administrator for more information. 

 IM awareness 
If your company uses the IBM Sametime instant messaging (IM) application, 
you can select this field to see the Sametime status of your Sametime contacts 
(buddy list). If you do this, a symbol next to the name of the sender of an 
e-mail in a mailbox indicates his or her Sametime status: Away , In a meeting 

, Do not disturb , or Available . Please note that in order to use this 
feature, Network push must be enabled as well (see above). 

 Enable Home screen plugin (Smartphone only) 
In this field you can specify DME is added to your Home screen plugin, if this 
plugin is enabled on your Smartphone. Please note that the Home screen plugin 
can put a considerable strain on your Smartphone's resources. 

 Login Close key 
In this field you can specify the action of the secondary key when the Login 
screen is shown. The following choices are available: 
 Exit: This is the default setting. Pressing the secondary key exits the DME 

application. 
 Hide: If you select this option, pressing the secondary key will hide (minimize) 

DME without logging out the user. This corresponds to pressing the red 
end-call key. Note that by selecting this, both the Exit action and the Login 
action are moved in as sub-items in the DME menu. 

 Desktop Close key 
In this field you can specify the action of the secondary key when the Desktop is 
shown. The following choices are available: 
 Lock: This is the default setting. Pressing the secondary key from the Desktop 

locks DME and shows the Login screen. 
 Hide: If you select this option, pressing the secondary key will hide (minimize) 

DME without logging out the user. This corresponds to pressing the red 
end-call key. 

 

Security settings 
With these settings, you specify the security aspects of DME on your device. 
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 Action on SIM change 
In this field you can choose how the DME client should react when a new SIM 
card is inserted into the device. You may need more than one SIM card, for 
instance if you travel and use local prepaid SIM cards. However, simply allowing 
SIM card changes poses a security threat, as a malevolent user might steal a device 
and insert his own SIM card in order to (potentially) gain access to files and other 
data on the device. Therefore you can choose among three options in this field: 
 None 

If you select this option, the DME client will do nothing when a user changes 
SIM cards. This is usually not recommended for the above stated reasons. 

 Flush data 
If you select this option, the DME client will flush (delete all DME data from) 
the device if another SIM card is inserted. For more information, see Data 
security on page 7. 

 Lock device 
When the DME client detects the SIM card change, the client automatically 
switches to Lock device mode (Shell protection). You now have to log in to 
DME in order to use the device. You have as many chances to enter the correct 
password as the option Limit on password attempts specifies. Just before 
logging in, DME checks if the current SIM card has been used before. If it has 
not, the user is prompted to enter the phone number for the new SIM card. 
This phone number and the SIM card identification number (IMSI) are stored 
and thus recognized the next time the same SIM card is inserted. A maximum 
of 62 pairs of phone numbers and SIM card IDs can be stored in this way. 

 Logout timeout (min) 
The DME client is locked automatically after the specified number of minutes of 
inactivity. The value 0 means never logout automatically (not recommended). 
Permitted range: 0-600 minutes. 

 Private key password 
In this field you can specify your password for your private key. Your private key 
is used for decrypting encrypted messages sent to you, and for signing private 
messages. If you do not enter a password here, you cannot read encrypted 
messages or sign new messages from your mobile device. 
If your collaboration system is using Notes Encryption, you must enter the 
password for your user ID file. 
If your collaboration system is using S/MIME, enter the password for your private 
key in this field. You must also upload your personal certificate to the DME server 
(using myDME).  
For more information about Notes Encryption, S/MIME, and myDME, please 
contact your DME administrator. 

 Lock device 
If you select Enabled, the device is completely locked when you log out of the 
DME client. You are only able to receive voice calls, make emergency calls, 
receive (but not view) text messages, and respond to calendar alarm messages. For 
maximum security, enable the setting “Launch on startup” in the General settings 
(see General settings on page 66). This way, this level of security is maintained 
even if the device is rebooted. Furthermore, the DME client will automatically 
restart if it should crash. 
If you select Disabled, the device is not locked when you log out of the DME 
client. 



70 
 

DME Client User Guide 3.6 : ©2011 Excitor A/S 
 

 Lock Messaging 
If you select Enabled, you can only access the messaging applications 
(SMS/MMS etc.) on the device when you are logged in to the DME client. If you 
log out of DME and attempt to open the messaging application, the following 
message is shown: 

 
When you accept the message, focus is changed to DME (or DME is launched), 
allowing you to log in. When logged in, focus is automatically changed back to the 
messaging application.  
If you select Disabled, the messaging applications are never locked. 

 Lock Calendar 
If you select Enabled, you can only access the calendar on the device when you 
are logged in to the DME client. See Lock Messaging above. 
If you select Disabled, the calendar is never locked. 
Note that if you lock the Calendar, Contacts and Tasks are locked also. 

 Lock Contacts 
If you select Enabled, you can only access the Contacts application on the device 
when you are logged in to the DME client. See Lock Messaging above. 
If you select Disabled, the Contacts application is never locked. 
Note that if you lock Contacts, Tasks and the Calendar are locked also. 

 Lock To-do 
If you select Enabled, you can only access the To-do (Tasks) application on the 
device when you are logged in to the DME client. See Lock Messaging above. 
If you select Disabled, the Tasks application is never locked. 
Note that if you lock To-dos, Contacts and the Calendar are locked also. 

 

E-mail settings 
In the e-mail settings screen you specify the synchronization and other aspects of 
e-mail in the DME client on your device. 
 E-mail sync. 

If you select Enabled/On, e-mail synchronization is enabled. This setting affects 
push mail, e-mail pull, manual synchronization, and scheduled sync. 
If you select Disabled/Off, e-mails are never synchronized. 

 Days back 
When e-mails are synchronized, e-mails from the last number of days selected 
here will be synchronized and available in the Inbox. Permitted range: 0-99 days. 

 Send immediately 
If you select No, e-mails are stored in the Outbox folder when you select Send, 
and are not sent until the next scheduled or manual synchronization. 
If you select Send only, e-mails created on the device are sent immediately when 
you select Send from a new e-mail or meeting invitation, but any new items are 
not retrieved from the server. This significantly reduces the load on the server and 
the time it takes to synchronize. 
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If you select Send & Retrieve, e-mails created on the device are sent immediately 
when you select Send from a new e-mail or meeting invitation - that is, a regular 
e-mail synchronization is performed. 

 Delete only locally 
If you select Yes/On, e-mails deleted from the DME client will only be deleted on 
the device, and not on the collaboration system. This is the default. 
If you select No/Off, e-mails deleted on the client will be removed from both the 
DME client and the mail system at the next scheduled or manual synchronization. 

 Quick reply 
In this field you can specify the function of the option Quick reply in an open 
e-mail. You can choose among the following options: 
1. To sender with history 
2. To sender without history 
3. To all with history 
4. To all without history 
When you select Quick reply in an open e-mail, DME will perform the function 
specified in this field. 

 Sound on 
If you select this check box, the device will play the sound selected in the field 
Mail alert when you receive an e-mail in DME. 
 Alerts start 

In this field you can specify the time of day from which you want to begin 
receiving audible alerts when a new e-mail arrives. Use the local time format, 
for instance hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 Alerts end 
In this field you can specify the time of day from which you no longer want to 
receive audible alerts when a new e-mail arrives. Use the local time format, for 
instance hh:mm:ss or hh:mm:ss am/pm. Example: 18:00 or 06:00 am. 

 Mail alert 
In this field you can specify the sound you want played when a new mail is 
received by DME. 

 E-mail pull 
If you select Enabled, client-initiated (pull) synchronization of e-mail is enabled. 
This corresponds to the Scheduled sync. settings on page 75, but is independent of 
the synchronization schedule set up on the DME server. 
Select Disabled to disable the client-initiated sync. of e-mail. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming. 
 Pull interval 

If E-mail pull is enabled, the client will initiate a sync. every number of 
minutes selected here. Permitted range: 10-120 minutes. 

 Start time 
In this field you can specify the time of day after which client-initiated pull 
should start, if this is enabled. Use the local time format, for instance 
hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
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In this field you can specify the time of day at which client-initiated pull 
should end, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, client-initiated pull will continue to run over the weekend. 
If you select No, client-initiated pull will not run on weekends. 

 Signature 
Any text you enter in this field will be appended to all new e-mails sent from the 
DME client. You typically use it for adding a signature. Note that the DME 
administrator can add another text to be appended to e-mails, called an "E-mail 
disclaimer". DME will add the signature from this field first, and then the e-mail 
disclaimer will be added by the DME server at the very end of the e-mail (after 
any reply history). 

 

Folders sync. 
 Folders sync. 

In this field you can choose to enable synchronization of e-mails in subfolders by 
default. The e-mails are synchronized for the number of days specified in the Days 
back field. You can change the setting for individual e-mail folders (see Setting 
folder options on page 23). 
Regardless of this setting, the folder structure as such (without e-mails) is 
synchronized between the collaboration system and the device. You need the 
folder structure when choosing where to search for e-mails on the server - see 
E-mails (on server) on page 40 and for moving e-mails to other folders. 

 Days back 
In this field you can specify how many days back the DME client should 
synchronize e-mails in subfolders. Note that with higher numbers, the load on the 
DME server will increase. This number may be changed for individual folders. 

 Apply to all folders now 
This option will always be off when you open the folder settings tab. Think of this 
option as an action button - if you select it, the settings for Days back and Sync. 
folders made in this window will be applied to all folders instantly, regardless of 
their individual settings. This is a way to realign all folder settings with default 
values. 

 

Calendar settings 
In the calendar settings, you specify the synchronization and other aspects of calendar 
items in the DME client on your device. 
 Calendar sync. 

If you select Enabled, calendar synchronization is enabled. This setting affects 
push notification, calendar pull, manual synchronization, and scheduled sync. 
If you select Disabled, calendar items are never synchronized. 

 Calendar mode (current mode) 
With this setting, you can change the security level of the DME Calendar's 
interaction with the native calendar on your device (requires DME Server 3.5). If 
you are not synchronizing with a 3rd party calendar (such as Google), you can 
choose among three options: 
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 Open: Calendar entries from DME are shown in the native calendar. Entries 
from the native calendar are synchronized with DME. 

 Mixed: As Open, but potentially sensitive information (that is: Subject, Body, 
and Location) in the native calendar is replaced by a DME security message, 
saying that the fields can only be viewed in the DME calendar. The fields 
mentioned are furthermore encrypted before they are saved to the device disk. 
Choose this setting if you want high security, but you also want to make use of 
calendar alarms. 
Note that neither of the Copy... settings can be selected if you are also 
synchronizing with a 3rd party calendar (such as Google). 

 Secure: There is no interaction between DME and the native calendar. 
Note that with this setting, calendar alarms are also disabled. 

When you change this setting, it will not take effect until you have synchronized 
the device. If the current mode (shown after the Calendar mode label) is different 
from your selection, you need to synchronize the device for the setting to take 
effect.  
For more information, see Interaction with native calendar on page 44. 

 Days back 
When items are synchronized, items from the last number of days selected here 
will be synchronized and available in the device. See To-do for more information. 

 Days forward 
When items are synchronized, items up until the number of days selected here will 
be synchronized and available in the Calendar. 

 Calendar pull 
If you select Enable, client-initiated (pull) synchronization of calendar items is 
enabled. This corresponds to the Scheduled sync. settings on page 75, but is 
independent of the synchronization schedule set up on the DME server. 
Select Disable to disable the client-initiated sync. of calendar items. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming. 
 Pull interval 

If Calendar pull is enabled, the client will initiate a sync. every number of 
minutes selected here. 

 Start time 
In this field you can specify the time of day after which client-initiated pull 
should start, if this is enabled. Use the local time format, for instance 
hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which client-initiated pull 
should end, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, client-initiated pull will continue to run over the weekend. 
If you select No, client-initiated pull will not run on weekends. 
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Contacts sync. settings 
 Contacts sync. 

If you select Enabled/On, contact synchronization is enabled, and your list of 
contacts on the device will be kept in sync with your personal address book on the 
collaboration system. 
If you select Disabled/Off, contacts are never synchronized. 

 Device Address Book/Contacts 
With the settings in these fields you can choose how DME should interact with the 
native address book on your device - the Contacts application. DME contains an 
internal address book - the DME Address Book. You can choose to keep your 
business contacts in the DME Address Book and your private contacts in the 
native Contacts application - for reasons of security, work/life balance, or both. 
The degree of interaction can be chosen at three levels: 
 Copy all fields (Open): Contacts from DME are shown in the native Contacts 

application, and the two address books are kept synchronized insofar as the 
native contacts application supports the DME address book fields. Note that 
when you select this option, DME will start exporting contacts to the Contacts 
application immediately. 

 Copy name and phone numbers (Mixed): As Copy all fields, but only the 
name and phone numbers from the DME Address Book are shown in the 
native Contacts application. If you edit the name or phone number in your 
native Contacts application, this information will be synchronized to the DME 
Address Book. However, if you add any other information to your native 
contacts, this information will be removed again by DME. In other words, you 
should use DME for maintaining your contacts. Note that when you select this 
option, DME will process the contacts in the Contacts application 
immediately, so they only show name and number. 

 Don't use (Secure): There is no interaction - contacts in the DME Address 
Book and the native Contacts are kept completely separate. This lets you keep 
your business contacts in DME in sync with your collaboration system, while 
letting you synchronize your personal contacts with other contact 
synchronization applications. Note that when you select this option, DME will 
delete any contacts in the Contacts application, which are also found in the 
DME Address Book, immediately. 

For more information, see Interaction with the device Contacts on page 56. 
 

To-do settings 
 To-do sync. 

If you select Enabled, to-do item synchronization is enabled. This setting affects 
push notification, manual synchronization, and scheduled sync. 
If you select Disabled, to-dos are never synchronized. 

 Days back 
When to-dos are synchronized, items from the selected number of days back in 
time will be synchronized and available in the device. See To-do for more 
information. 
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 Days forward 
When to-dos are synchronized, items with a date up until the selected number of 
days ahead in time will be synchronized and available in the device. 

 

Notes sync. settings 
 Notes sync. 

If your collaboration system is Lotus Domino, you are able to synchronize notes 
(journals) from your Lotus Notes when you enable this option. 
If you disable this option,notes are never synchronized. 

 Days back 
When notes are synchronized, items from the selected number of days back in 
time will be synchronized and available in the device. See Notes on page 60 for 
more information. 

 Days forward 
When notes are synchronized, items with a date up until the selected number of 
days ahead in time will be synchronized and available in the device. 

 

Feed sync. settings 
 Feed sync. 

Feed sync. must be enabled if you want to use the built-in DME feed reader. For 
more information, see Feeds on page 60. 

 Max. articles in feed 
This setting determines how many articles DME is permitted to download per 
feed. Options are Unlimited, 50, or 100. 

 

Files settings 
With these settings, you enable or disable the synchronization of files. File 
synchronization requires a special license and is set up on the DME server. For more 
information, please ask your DME administrator. 
 File sync. 

If you select Enabled, file synchronization is enabled. This setting affects push 
notification, manual synchronization, and scheduled sync. 
If you select Disabled, files are never synchronized. 

 

Scheduled sync. settings 
With these settings, you specify options for scheduled synchronization. Note that this 
feature may be disabled if you are roaming. For more information, see Roaming. 
 Scheduled sync. 

If you select Enabled, the DME client will initiate synchronization of the enabled 
resources (e-mail, calendar, etc.) according to the schedule specified below. 
If you select Disabled, the synchronization of resources relies on client-initiated 
sync (pull, where applicable), manual synchronization, or push notification from 
the mail system. 
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 Interval 
If Scheduled sync. is enabled, the client will accept a sync. every number of hours 
selected here. Permitted range: 1-24 hours. 

 Start time 
In this field you can specify the time of day after which scheduled sync. should 
start, if this is enabled. Use the local time format, for instance hh:mm:ss or 
hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which scheduled sync. should end, 
if this is enabled. Use the local time format, for instance hh:mm:ss or hh:mm:ss 
am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, scheduled sync. will continue to run over the weekend. 
If you select No, scheduled sync. will not run on weekends. 

 

Shortcuts settings 
In this screen, you can change the shortcuts defined for your device. For each of the 
ten fields in this screen (*0 - *9), you can select one of the available options: 

Shortcut option Action 
<blank> Removes any existing shortcut definition. The shortcut will do 

nothing. 

Sync. e-mail Synchronize e-mail. 

New e-mail Create a new e-mail. 

Open inbox Open the Inbox. 

View folders Open the Folders screen to change to another e-mail folder. 

Open calendar Open the internal DME calendar. 

Open contacts Open the Contacts application. 

Global Address Book Search the Global Address Book to find a contact. 

Search e-mails Search for e-mails on the collaboration system. 

Mark read Mark selected e-mail or e-mails as read. 

Mark unread Mark selected e-mail or e-mails as unread. 

Move to folder Move selected e-mail or e-mails to an e-mail folder of your choice. 

New meeting Create a new meeting invitation. 

Sync. calendar Synchronize the calendar according to settings. 

Sync. contacts Synchronize your contacts. 
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Sync. to-do Synchronize to-dos according to settings. 

Sync. files Synchronize files according to settings. 

Sync. all Synchronize everything according to settings. 

For information about how to use shortcuts, see Shortcuts on page 21. 
 

Desktop settings 
 Log in to 

In this field you can specify which screen you want to see after logging in to the 
DME client. You can choose between the following options: 
 Last Used: DME remembers which of the below views was active when you 

last logged out of DME, and starts here when you log in again. 
 Desktop: DME starts in the Desktop view after logging in. 
 Inbox: DME opens the Inbox after logging in. 
 Calendar: DME opens the Calendar after logging in. 
 To-do: DME opens the To-do view after logging in. 
 Notes: DME opens the Notes (Journals) view after logging in. Applies to Lotus 

Notes users only. 
 Feeds: DME opens the Feeds view after logging in. 
For more information, see The DME Desktop on page 20. 

 Background 
In this field you can specify the color of the Desktop background. You can choose 
between the following two options: 
 Dark: The Desktop is shown with a dark background. 
 Light: The Desktop is shown with a light background. 
The background is not affected by any choice of theme on the device. 

 Startup sound 
If this field is set to Enabled, DME will play a sound when you launch the client. 

 

Menu tree 
If you have access to the full DME client, the menu structure of the DME client is as 
follows. Note that the DME menu structure is dynamic. If your license does not 
include all functionality, or if some functionality is turned off by the DME 
Administrator, there will be less menu items than shown below. 
 

Create 
 E-mail 

Create a new e-mail. 
 Meeting 

Create a new meeting invitation or appointment. 
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Synchronize 
 E-mail 

Synchronize e-mails only. 
 Calendar 

Synchronize calendar items only. 
 Contacts 

Synchronize contacts only. 
 To-do 

Synchronize to-dos (tasks) only. 
 Files 

Synchronize files only, if enabled. 
 RSS 

Synchronize RSS feeds only, if enabled. 
 Sync. all 

Synchronize all resources. 
 Cancel sync. 

Cancel an ongoing synchronization. Any changes made will be rolled back. 
 

Actions 
Available in e-mail folders. 
 Mark read 

Mark e-mails as read (Selected or All). 
 Mark unread 

Mark e-mails as unread (Selected or All). 
 Delete 

Delete selected e-mail (Delete or Backspace on virtual keyboard). 
 Delete all attachments 

Delete all attachments downloaded to the device. 
 Sort 

Sort current folder by date, name or subject (ascending or descending). 
 Move to folder... 

Move the selected e-mail to an e-mail folder. 
 Call 

Place a voice call to the number associated with the sender of the current e-mail. 
 

Search 
 Global Address Book 

Search for e-mail address on the server. 
 E-mails (on server) 

Search for e-mails in your server mailbox. 
 E-mails (on phone) 

Search for e-mails stored locally. 
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Tools 
 Settings 

Set up different aspects of DME on your device: General, Security, E-mail, Folders, 
Calendar, Contacts, To-dos, Files, Scheduled sync., Desktop. 

 Reset 
Reset (wipe and load) all synchronized items from the collaboration system to 
your device. 

 Out of office 
Manage your out of office agent or rule. 

 Change password 
Change your LDAP/AD password to match that on the server. 

 Set PIN code 
Set a PIN code as a temporary double of your LDAP password. 

 Cost Control 
View your Cost Control balance. 

 Log 
Show the client's event log, and optionally save it as a file. 

See Tools for more information. 
 
 

View 
 Folders 

Go to the Folders view, where you can choose which mailbox folder you want to 
work in. 

 Calendar 
Go to the internal DME calendar. 

 Contacts 
Go to the internal DME contacts. 

 To-do 
Go to the to-do list. 

 Notes 
Go to the Notes view (Domino only). 

 RSS 
Go to the RSS Feeds list. 

 
 

About DME 
 About DME 

Display version information, OS information, and license agreement text. 
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If you need further assistance 
If you have read this guide and still have questions concerning the function and usage 
of the DME client, please contact your DME Help Desk (usually the internal IT 
department). 
Before contacting your DME Help Desk, be sure to have information about your DME 
version etc. ready: 

 Finding helpdesk information about your DME client 
1 Open the DME menu. 
2 Select About DME. 

 
A window displays information you can use in connection with helpdesk inquiries. 
Apart from the product name and a copyright notice, the window shows the 
following information: 
 Version number (for instance 3.6) 
 Build release date (for instance 2011-10-20 11:48) 
 Device platform 
 OS and .Net framework details 
 DME copyright and license information 

Furthermore, DME keeps a log of the events that take place in the client. 

 Showing the DME client event log 
1 Open the DME menu. 
2 Select Tools. 
3 Select Log. 

 
Tap Send log to save the log to disk, open a new e-mail, and attach the log as a set 
of files: system.txt, app_error.txt, and sync_error.txt. This is 
especially useful if you need to send the log to support. 

The DME administrator can request the client event log using a feature in the DME 
Server. 
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If you are the DME administrator, and you need more help, you can contact your 
DME Partner. You can also check the DME Support http://www.excitor.com website 
for more information. 
If you find errors or omissions in this documentation, please contact Documentation 
feedback see Documentation feedback - 
mailto:documentation@excitor.com?Subject=Documentation feedback. 
 

http://www.excitor.com/
mailto:documentation@excitor.com?Subject=Documentation%20feedback
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